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Installing the Sample Files 

 

Our sample files are available for you to download from the Internet onto 

your own computer.  Each course has a set of sample files which have been 

compressed into a single, executable file with the extension “.exe”.  You will 

need to download the file from the Internet and extract the sample files into 

their folder before they can be opened by the appropriate application.  

 
1. Launch Internet Explorer or your Web Browser and go to the following website: 

 

www.fullcirclecomputing.com/samplefiles.htm 

 

2. You will find a table listing our courses by application and level.  Locate the course 

you intend to practice, and click on the hyperlink. 

 

3. Click the Open button to begin the download of the file to a temporary folder.  The 

download may take a few minutes to complete. 

 

4. Now an Extract dialog box will appear.  Notice the location the file will be extracted 

to.  You might want to write this down so you will know where to find it later. 

 

5. Click the Extract button.  If asked, click Yes to create a new directory.  The extract 

may take a few minutes to complete. 

 

6. Click OK when completed. 

 

7. You will now be back to the sample files table.  Close the Internet Explorer window. 
 

Launch the application you are planning to practice.  You will now be able 

to open the sample files normally from the location you extracted to in step 4 

above. 

 

http://www.fullcirclecomputing.com/samplefiles.htm
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LESSON 1 -  
REVIEWING PROJECT BASICS  

In this lesson, you will learn how to: 

 Change project information  

 Enter tasks  

 Edit tasks  

 Enter a milestone task  

 Enter a recurring task  

 Edit recurring tasks  

 Indent and outdent tasks  

 Insert a task  

 Delete a task  

 Move a task  

 Link tasks  

 Unlink tasks  

 Enter a start or finish date  
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EXERCISE 

REVIEWING PROJECT BASICS 

 Task 

Practice using project basics. 

 

1. Create a new blank project. 

2. Define a new project and enter a start date of 6/19/06. 

3. Save the project to the student data folder as Rooms1. 

4. Designate November 23rd and 24th in the year 2006 as nonworking 

days. (Hint: Drag or hold [Ctrl] to select both dates.) 

5. Enter the following tasks in the first available fields in the Task 

Name column: 

 

Task Name Duration 

Create Plan 2 days 

Plan Approval 6 days 

Get Permits 1 day 

Paint Board Room 3 days 

Lay Carpets in Board Room 3 days (estimate) 

Trim Board Room 2 days 

 

6. Enter a milestone task in the next empty field in the Task Name 

column with the name Board Room Complete. 

7. Enter the following recurring task in the next empty field: 

 

Task Name Report Progress 

Duration 1 hour 

Frequency Weekly, Tuesday and Thursday 

 

8. View the subtasks for the Report Progress recurring task. 

9. Change the duration of the Report Progress 1 subtask to two hours 

and change the start date to Wed, 6/21/06. 

10. Change the recurring task frequency for the Report Progress task 

from Tuesday and Thursday to Monday and Thursday. 
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11. Insert the Renovate Board Room task above the 4 Paint Board 

Room task. Make the 5 Paint Board Room to the 8 Board Room 

Complete tasks subtasks of the Renovate Board Room task. 

12. Move the 6 Lay Carpets in Board Room task below the 7 Trim 

Board Room task. 

13. Link the 1 Create Plan through 8 Board Room Complete tasks. 

14. Enter a day of lag time between the 6 Trim Board Room task and 

the 7 Lay Carpets in Board Room task. 

15. Insert the Install Board Room Furniture task above the 8 Board 

Room Complete task. 

16. The movers are coming on July 17th to install the Board Room 

furniture. Enter a start date of 7/17/06 for the 8 Install Board Room 

Furniture task and keep the link. 

17. Save and close the project. 

 

 





 

 

LESSON 2 -  
WORKING WITH CALENDARS  

In this lesson, you will learn how to: 

 Use calendars  

 Modify individual resource calendars  

 Modify a calendar  

 Change resource availability over time  

 Create a base calendar  

 Assign a base calendar to resources  

 Assign a base calendar to a project  

 Assign a calendar to a task  
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USING CALENDARS 

 Discussion 

When you first start a project, the Standard base calendar is applied to the project and 

is referred to as the project calendar. This calendar sets Monday through Friday, from 

8:00 AM to 5:00 PM, as working time, and Saturday and Sunday as nonworking time. 

When you begin to enter task and resource information, your project schedule is set 

according to the default project calendar. 

 

The default working and nonworking times in the Standard calendar may not apply 

to your particular project. While Microsoft Project also provides two other base 

calendars, Night Shift and 24 Hours, these may not work for your project either. In 

this situation, you can create a new base calendar, containing the working and 

nonworking times specific to your project, and then apply it to the project, thus 

creating a new project calendar. If you need to create a new project calendar, you 

should do so before entering any project information. 

 

If you find that the Standard calendar works for your project, with the exception of 

certain resources, you have two options. You can modify an individual resource 

calendar by setting working hours and nonworking time specific to a particular 

resource. You can also create a new base calendar and assign it to all resources that 

adhere to the same schedule. Either way, you create a new resource calendar. You can 

modify resource calendar options and create a new resource calendar before you 

assign resources to tasks or after making the assignments. If resources are already 

assigned to tasks, the schedule will adjust according to the new resource calendar 

settings. Modifying resource calendar options is particularly helpful for marking 

vacation time on the calendar. Resource calendars do not apply to material resources. 

 

You can also create a resource calendar by changing a resource’s availability over 

time. When you change a resource’s availability, you indicate the maximum units 

available during certain time periods. That way, tasks are scheduled according to 

when the resource is available. For example, you could change a resource’s 

availability if the resource is available to work part-time (units = 50%) in July and 

August and full-time (units = 100%) in September and October. 

 

Task information is also scheduled according to the Standard project calendar by 

default. However, if you have tasks that must be worked on during certain hours or 

days of the week, you can create a task calendar. To create a task calendar, you create 

a new base calendar to reflect the task’s schedule and then assign it to the appropriate 

task(s). 
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MODIFYING INDIVIDUAL RESOURCE CALENDARS 

 Discussion 

When you create a new resource, Microsoft Project creates a calendar for the resource 

based on the project calendar. However, all resources in your project may not work 

during the same hours as the default working times set in the project calendar. Some 

resources may only work four hours a day and some may work ten hours a day. In 

addition, some resources may be taking a vacation or only work three days a week; 

therefore, the default nonworking time would not apply. Changing the working and 

nonworking time for a resource is very important as it will affect your project 

schedule. 

 

The Change Working Time dialog box allows you to change the working hours for a 

resource and mark nonworking days. When you change the working hours for a 

resource, you need to make sure that the start time is not earlier than the default start 

time (8:00 AM by default or the default time set by you). The finish time (5:00 PM by 

default or the default time set by you), however, can be later than the default finish 

time. You can change the working time for a day, week, month, etc. 

 

Use the Exceptions tab to set occasional changes to the normal working times, such 

as holidays, personal time off, vacations, and so on. Use the Work Weeks tab to set 

up the normal work week for a resource. For example, if a resource does not work on 

Fridays, use the Work Weeks tab to change every Friday to a nonworking day. Also 

use the Work Weeks tab to set up alternate or temporary work weeks. For example, 

you can specify that a resource will be working an extended work week for a rush job, 

or a reduced work week throughout August. 

 

By default, the Standard project calendar defines the nonworking days for a project 

as Saturday and Sunday. Once you create resources, you can mark nonworking days 

for individual resources. 
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Modifying an individual resource calendar 

 

  

 
To mark multiple days in the same calendar as nonworking 

time or change the working hours for those days, drag to select 

consecutive days before you name the Exception. If adjusting 

Work Weeks, you can select consecutive days or hold the 

[Ctrl] key and click the desired non-consecutive days after 

you click the Details button. 

  
 

  

 
If you change a resource’s start time to a time earlier than the 

task start time (either the default or the one set by you), 

Microsoft Project will ignore the work hours before the task 

start time and the task duration will be impacted. 

  
 

 Step-by-Step 

From the Student Data directory, open HOUSE7.MPP. 

Modify a calendar for an individual resource. 

 

In the Gantt Chart view, scroll to the week of Jul 23, ‘06. 

 

Notice that the Superintendent resource is scheduled to work on the 8 Select 

Subcontractors task, which has a duration of one week. Point to the Gantt bar for the 

task and view the start and finish dates to see that the task is scheduled from Monday 

through Friday for five working days.  



Project - Lvl 2 Lesson 2 - Working with Calendars 

 Page 9 

 

 

Steps Practice Data 

1. Switch to the Resource Sheet view 

and double-click the resource with the 

calendar you want to change. 

The Resource Information dialog box 

opens. 

Double-click the 

17 Superintendent 
resource 

2. Select the General tab. 

The General page appears. 

Click the General tab 

3. Select Change Working Time. 

The dialog box appears. 

Click the Change 

Working Time button 

4. Select the date(s) or day(s) of the week 

that you want to change. 

The date(s) are selected.  

Click on any day in the 

week of 7/23 

5. If setting nondefault working hours, 

select the Work Weeks tab. 

The Details for [Default] working time 

dialog box appears.  

Click the Work Weeks 

tab, and click the Details 

button 

6. Select the day(s) you want to change 

working time for. 

The day(s) of the week are selected.  

Highlight Sunday through 

Saturday 

7. Select the Use times from base 

calendar, Set days to nonworking 

time, or Set days to specific working 

times option as desired. 

The desired option is selected.  

Click  Set day(s) to 

these specific working 

times: 

8. Set the time you want to change in the 

From and To column.  

The desired time is selected. 

Click in the first From 

box and type 8:30 AM, 

and continue entering 

times as shown in the 

diagram below 

9. Select OK. 

The dialog box closes and the working 

hours for the resource have changed. 

Click OK 
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Modifying default working time for an individual resource 

Switch to the Gantt Chart view. Point to the task bar for the Select Subcontractors 

task and notice that the task, while still showing a duration of one week, is scheduled 

from Monday through Thursday for a total of four business days. The scheduling 

change occurred because the Superintendent works more than eight hours a day. 

 

Practice the Concept: Scroll to view the 4 Request Bids task and point to the Gantt 

bar for the task to see that it starts on 6/23/06 and finishes on 6/29/06, with a duration 

of 1 week. Notice that the task duration includes two days marked as nonworking time 

(June 24 and 25). Switch to the Resource Sheet view and open the Resource 

Information dialog box for the 6 Contracting Specialist resource. From the Change 

Working Time dialog box, scroll to view the June 2006 calendar and mark June 28, 

29, and 30 as nonworking time. Select the desired dates and from the Exceptions tab, 

enter the Name “CS Vacation”. Click to the Start date to populate the dates. Click 

Details and select  Nonworking. Then click OK to close the dialog box and apply 

the changes. 

 

Switch to the Gantt Chart view and point to the Gantt bar for the 4 Request Bids 

task again. Notice that the task now finishes on 7/6/06. The schedule was adjusted 

since the nonworking time of the resource occurred during the time the resource was 

scheduled to work on the task. 

SETTING RESOURCE-SPECIFIC WORK HOURS 

 Discussion 

This example leads you through the steps to select a base calendar template, and set 

the working days and starting and ending times for the resource. Although the base 

calendar template defines the holidays and standard nonworking days such as 

Saturday and Sunday, you can select additional nonworking days for the resource 

using the Change Working Times dialog box.  
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 Step-by-Step 

Setting Resource-specific work schedules. 

 

In the Gantt Chart view, select the 25 Initial Electricity task and scroll to view the 

Gantt bar for the task. Notice that the Electrician resource is scheduled to work on the 

task, which has a duration of two weeks. Point to the Gantt bar and view the start and 

finish dates to see that the task is scheduled from Tuesday 9/26/06 through Monday 

10/9/06 for ten working days. 

 

The electricians do not work on Fridays, but work two extra hours from Monday to Thursday to 

make up the time.  

Steps Practice Data 

1. Click the Project tab on the ribbon. Click the Project tab 

2. Click the Change Working Time 

button 

Click  

3. Select the resource whose calendar 

you want to create. 

The selected resource appears under 

the For Calendar text box  

Click 3 Electrician 

4. Select the Work Weeks tab.. Click  the Work Weeks 

tab  

5. Then click the details button to open 

the details dialog box. 
Click  

6. Select or deselect the days of the week 

the resource will or will not work from 

the Select Days list on the left. 

 

Click  Friday then click 

Set Days to 

Nonworking Time 

7. Click OK to accept the change. 
Click   

8. Click the details button again to 

reopen the details dialog and adjust the 

working times for all days or 

individual days as needed. 

Click and drag to select 

Monday through 

Thursday  

9. Choose the option to override the 

standard work schedule hours 
Set Day(s) to these 

specific working times 
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Steps Practice Data 

10. Enter the new scheduled working 

times 

Change the working hours 

so that the electricians 

finish at 7 PM 

11. Click OK to accept the change. 
Click  

 

Switch to the Gantt Chart view. Scroll down to the 25 Initial Electricity task and 

point to the task bar. Notice that the starting and ending dates have remained the same. 

The Electrician resource is still working 40 hours per week; instead of five 8-hour 

days, the resource is now working four 10-hour days. 

CHANGING RESOURCE AVAILABILITY OVER TIME 

 Discussion 

In addition to changing a resource’s working and nonworking time, you can also 

create a resource calendar by changing a resource’s availability over time. When you 

change availability, you indicate the maximum units available for a resource during 

certain time periods. For example, a project starts September 1 and ends on November 

30. A particular resource is available to work on the project, but only during the 

months of September and October. You could change the resource’s availability to 

indicate that the resource is available (units = 100%) during those two months, and 

not available (units = 0%) during the month of November. Then, if you attempt to 

assign that resource to a task in November, the resource will be identified as 

overallocated. In most resource views, overallocations appear in red. 

 

After you change a resource’s availability, the Max. Units field in the resource sheet 

reflects 0%. This occurs since the maximum unit value varies over time and one value 

does not apply to this particular resource. To view the resource’s availability, you can 

open the Resource Information dialog box for the resource and view availability on 

the General page. 
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Changing a resource's availability over time 

 Step-by-Step 

Change a resource’s availability over time. 

 

Switch to the Resource Sheet view. Notice that 200% appears in the Max. Units 

field for the 4 Plumber resource. 

 

Steps Practice Data 

1. Double-click the resource for which 

you want to change the availability. 

The Resource Information dialog box 

opens. 

Double-click the 

4 Plumber resource 

2. Select the General tab. 

The General page appears. 

Click the General tab 

3. Select the first Available From field 

in Resource Availability table. 

The first Available From field is 

selected and a down arrow appears. 

Click in the first 

Available From field 

4. Type the start date for the first time 

period. 

The date appears in the Available 

From field and in the entry bar under 

Resource Availability. 

Type 9/1/06 
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Steps Practice Data 

5. Press [Enter]. 

The date is entered into the Available 

From field. 

Press [Enter] 

6. Enter the end date for the first time 

period in the Available To field. 

The desired date appears in the 

Available To field. 

Click in the first 

Available To field, type 

10/31/06, and press 

[Enter]. 

7. Select the Units field. 

The Units field is selected. 

Click in the first Units 

field 

8. Enter the units available for the 

resource during the specified time 

frame. 

The units appear in the Units field. 

Click Units to 200%, if 

necessary 

9. Continue to specify the resource’s 

availability as necessary. 

The resource’s availability is entered. 

Follow the instructions 

shown below the table 

before continuing on  

10. Select OK. 

The Resource Information dialog box 

closes and the resource’s availability 

is changed. 

Click OK 

 

Use the information in the second row of the following table to complete the second 

row of the Resource Availability table: 

 

Available From Available To Units 

9/1/2006 10/31/2006 200% 

11/1/06 12/31/06 100% 

 

Return to the table and continue on to the next step (step 10). 

 

Notice that the Max. Units field for the Plumber resource reflects 0%, indicating that 

the resource availability varies over time. 

 

Switch to the Gantt Chart view and display the Gantt bar for the 33 Final Plumbing 

task. Notice that the Plumber resource is assigned to the task. Point to the task bar 

and notice that the task begins on 11/6/06. Select the Final Plumbing task, open the 

Assign Resources dialog box, and increase the maximum units for the Plumber 

resource to 200%. Press [Enter] and close the Assign Resources dialog box. Notice 

that a smart tag appears next to the 33 Final Plumbing task. Since the Microsoft 

Project took the default action for adding a resource and shortened the duration, you 

can ignore the smart tag. 
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Switch to the Resource Sheet view and notice that the Plumber resource appears in 

red, indicating it is overallocated. This overallocation occurred because the 

assignment unit is 200% during a time when the plumber’s availability is 100%. 

 

Return to the Gantt Chart view, double-click the 33 Final Plumbing task and use the 

Resources page in the Task Information dialog box to return the resource assignment 

of the Plumber to 100%. Ignore the smart tag to accept the default action, which 

increases the duration of the task. 

CREATING A BASE CALENDAR 

 Discussion 

A base calendar defines working and nonworking time. Microsoft Project includes 

three base calendars (Standard, 24 Hours, and Night Shift) that you can assign to 

your project, resources, and/or tasks. The Standard base calendar is assigned to the 

project by default. 

 

If none of the default base calendars meets your needs, you can create a new base 

calendar for a particular group of resources, a task, or for the entire project. Once you 

create a base calendar, you then need to assign it to the appropriate resource(s), 

task(s), and/or to the project. 

 

You can create a base calendar in one of two ways. The first way is to copy the project 

calendar, or one of the other default calendars available, and then modify it. Copying 

the project (Standard) calendar is helpful if you have already marked all the holidays 

on your project calendar. The second way is to create a new base calendar using the 

default settings (8:00 AM to 5:00 PM working hours; Saturday and Sunday 

nonworking days). 

 
The Create New Base Calendar dialog box 
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 Step-by-Step 

Create a base calendar. 

 

Steps Practice Data 

1. Select the Project Tab if necessary Click the  Project tab 

2. Select the Change Working Time 

command. 

The dialog box opens.  

3. The Create New Base Calendar dialog 

box opens with the text in the Name 

box selected.  

Click  the Create New 

Calendar... button 

4. Enter the name of the new base 

calendar. 

The name appears in the Name box. 

Type Site Workers1 

5. Select the Create new base calendar 

or Make a copy of <calendar name> 

calendar option. 

The desired option is selected. 

Click  Make a copy of 

<calendar name> 

calendar, if necessary 

6. Select the desired calendar from the 

calendar list, if appropriate. 

A list of available calendars appears; 

select the desired calendar. 

Click Standard from the 

<calendar name>  

7. Select OK. 

The dialog box closes. 

Click OK 

8. Modify the new base calendar as 

desired. 

The base calendar is modified. 

Scroll to view the calendar 

for August 2006 and 

select August 21-25 

9. Modify the new base calendar as 

desired. 

The base calendar is modified. 

On the Exceptions tab, 

click the next blank line 

and type Vacation in the 

name. Then click in the 

Start Date to populate the 

dates 

10. Modify the new base calendar as 

desired. 

The base calendar is modified. 

Click the Details button to 

mark August 21-25 as 

nonworking time 

11. Select OK. 

The dialog box closes and the changes 

to the base calendar are saved. 

Click OK 
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Practice the Concept: Create a new base calendar called Landscaping.  Base the 

calendar on the Standard calendar. Add Saturday as a working day and save the 

calendar. Open the Change Working Time dialog box and display the Landscaping 

calendar. Select any Saturday and notice that it is set to the default working times. 

Cancel the Change Working Time dialog box. 

 

Switch to Gantt Chart view. 

ASSIGNING A BASE CALENDAR TO RESOURCES 

 Discussion 

You may have a group of resources that have schedules different from the rest of the 

resources in a project. Instead of individually editing the resource calendar for each 

resource involved, you can create a new base calendar reflecting the group’s schedule 

and name it accordingly. When you change the working hours for a group, the same 

guidelines apply as when you change the working and nonworking time for an 

individual resource. 

 

After you create a base calendar for a group of resources that share a common work 

schedule, you need to assign the calendar to those resources. When you assign a 

calendar in the Resource Information dialog box, the working hours do not change 

until you close the dialog box. You can open the Resource Information dialog box 

again to see that the working hours displayed match the base calendar you assigned to 

the resource. In addition, you can only assign a base calendar to one resource at a 

time. 

 

  

 
You can also use the Base Calendar field in the Resource 

Sheet view to assign a base calendar. 

  
 

 Step-by-Step 

Assign a base calendar to resources. 

 

If necessary, switch to the Gantt Chart view. 

 

Scroll as necessary to view the task bar for the 16 Frame House task. Point to the 

Gantt bar to view the end date for the task and notice that it is scheduled to end on Fri 

8/25/06. Switch to the Resource Sheet view. 
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Steps Practice Data 

1. Double-click the resource to which 

you want to assign a new base 

calendar. 

The Resource Information dialog box 

opens. 

Double-click the 

9 Carpenter resource 

2. Select the Change Working Time 

button. 

The dialog box appears. 

Click the Change 

Working Time button 

3. Select the Base calendar list. 

A list of available base calendars 

appears. 

Click Base calendar  

4. Select the desired base calendar. 

The selected base calendar appears in 

the Base calendar box. 

Click Site Workers1 

5. Select OK. 

The Resource Information dialog box 

closes and the base calendar is 

assigned to the resource. 

Click OK 

 

Scroll to the right as necessary to view the Base Calendar field for the resource. 

 

Practice the Concept: Assign the Site Workers1 base calendar to the 1 Laborer 

resource. 

 

Switch to the Gantt Chart view and point to the task bar for the 16 Frame House 

task again. Notice that the Frame House task, to which the Carpenter resource is 

assigned, is now scheduled to end on Fri 9/1/06. The change occurred since the week 

of August 21-25, 2006 is nonworking time on the Site Workers1 base calendar. 

ASSIGNING A BASE CALENDAR TO A PROJECT 

 Discussion 

If the default project calendar does not meet the needs of your project, you can create 

a new project calendar. To create a new project calendar, you need to create a base 

calendar to reflect working and nonworking time specific to your project. Then, you 

need to assign the new base calendar to your project using the Project Information 

dialog box. 

 

If you need to use a new project calendar, you should do so before you enter project 

information. 
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 Step-by-Step 

Assign a base calendar to a project. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project ribbon appears. 

Click the Project tab 

2. Select the Project Information 

command. 

The dialog box opens. 

Click Project 

Information... 

3. Select the Calendar list. 

A list of available calendars appears. 
Click Calendar  

4. Select the calendar you want to assign 

to the project. 

The selected calendar appears in the 

Calendar box. 

Click Site Workers1 

5. Select OK. 

The dialog box closes and the base 

calendar is assigned to the project. 

Click OK 

 

Open the Change Working Time dialog box and notice that Site Workers1 (Project 

Calendar) appears in the For box. Cancel the dialog box. 

 

Practice the Concept: Open the Project Information dialog box and change the 

project calendar back to the Standard calendar. 

ASSIGNING A CALENDAR TO A TASK 

 Discussion 

You may have certain tasks that need to be worked on during hours that are different 

from the default project calendar. You can create a task calendar for these tasks by 

creating a new base calendar and then assigning that calendar to the appropriate tasks. 

 

When you assign a calendar in the Task Information dialog box, the working hours do 

not change until you close the dialog box. You can open the Task Information dialog 

box again to see that the working hours displayed match the base calendar you 

assigned to the task. You can assign a task calendar to one task or to multiple tasks at 

the same time. 

 

If resources are assigned to the task to which you assign a task calendar, the task is 

scheduled during the working times that are common to both calendars. If there are 

conflicting times, the resource calendar takes precedence. However, if you want the 
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task completed according to the task calendar, you can open the Task Information 

dialog box and select the Scheduling ignores resource calendars option. When you 

select this option, the resource calendar is ignored and the task is scheduled according 

to the task calendar. Therefore, the resource only works during the hours specified by 

the task calendar. 

 

You can quickly see which tasks have a task calendar assigned to them by looking for 

the Task Calendar indicator in the Indicators field in a task view. When you point to 

the indicator, the ScreenTip identifies the calendar assigned to the task and indicates if 

the calendar is set to ignore the resource calendar. 

 
Assigning a calendar to a task 

 

  

 
You can assign a task calendar to multiple tasks using the 

Multiple Task Information dialog box. After selecting the 

tasks, press Shift+F2 to open this dialog box. 

  
 

 Step-by-Step 

Assign a base calendar to a task. 

 

If necessary, switch to the Gantt Chart view. 

 

Scroll as necessary to view the task bar for the 38 Landscaping task. Point to the bar 

to see that the task begins on a Wednesday and ends on a Tuesday with a duration of 

one week. 
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Steps Practice Data 

1. Double-click the task to which you 

want to assign a calendar. 

The Task Information dialog box 

opens. 

Double-click the 

38 Landscaping task 

2. Select the Advanced tab. 

The Advanced page appears. 

Click the Advanced tab 

3. Select the Calendar list. 

A list of available base calendars 

appears. 

Click Calendar  

4. Select the desired calendar. 

The calendar is selected. 

Click Landscaping 

5. Select OK. 

The Task Information dialog box 

closes and the calendar is assigned to 

the desired task. 

Click OK 

 

Point to the Gantt bar for the 38 Landscaping task again and notice that nothing 

changed. Even though the Landscaping base calendar includes Saturday as a work 

day, the Landscaper resource, which is assigned to the task, adheres to the Standard 

calendar which designates Saturday as nonworking time. 

 

Open the Task Information dialog box again and select the Scheduling ignores 

resource calendars option on the Advanced page. Close the dialog box. Point to the 

Gantt bar for the Landscaping task again and notice that the task now finishes on 

Monday instead of Tuesday. The change occurred since the task calendar includes 

Saturday as working time and the resource calendar, which marks Saturday as 

nonworking time, is ignored. 

 

Point to the Task Calendar indicator to view the ScreenTip. 

Close HOUSE7.MPP. 

  





 

 

LESSON 3 -  
ADJUSTING RESOURCES  

In this lesson, you will learn how to: 

 Address resource overallocation  

 View resource usage  

 Resolve conflicts by increasing units  

 Level a resource  

 Specify leveling timeframes  

 Change the leveling order  

 Level by entering a delay amount  

 Clear leveling  

 Split a task  

 Change leveling to automatic  

 Set task level priority  
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ADDRESSING RESOURCE OVERALLOCATION 

 Discussion 

Microsoft Project schedules tasks in accordance with their specifications, such as the 

estimated durations, dependency relationships, date constraints, and resource 

availability. Tasks are scheduled to begin in the first available time slot on the 

resource calendar after any relationship requirements are satisfied. Microsoft Project 

does not consider that a resource may already be involved in another task. For 

example, if an employee is assigned to do three eight-hour tasks in one eight-hour 

day, the employee is overallocated. For this reason, you should review workloads to 

uncover allocation problems after you have assigned resources. 

 

When resource overallocation or conflicts arise, you must develop a strategy to 

resolve them. The following list provides ways to address overallocations: 

 

• Increase the number of resources available, when possible. This 

solution, of course, is not always economically feasible. 

• Add underallocated resources to the task to assist the overallocated 

resource. This solution is often the most satisfactory, but also 

requires more effort from the project manager. 

• Schedule overtime hours or weekend work for the overallocated 

resources to get the project back on track. This solution should be 

used when the overallocation is not substantial. 

• Change the resource calendar to reflect longer working hours. 

• Adjust task relationships or constraints so that a resource is not 

assigned beyond its capacity. 

• Delay tasks until a resource is available. Often, this solution is not 

viable when deadlines are involved. 

• Split a task so that a resource can work on it at a later time. 

 

Overallocated resources appear in red in most of the resource views. The Resource 

Usage view is one view in which you can clearly review resource allocation and see if 

any of your resources are overallocated. 

 

  

 
Resource amounts appear as a percentage. For example, if 

three plumbers are available to work full-time on any tasks, 

the maximum unit for the Plumber resource would be 300%. 

  

 
You can display resource amounts as decimals rather than 

percentages using the Show assignment units as a list in the 

Schedule page of the Options dialog box. 
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VIEWING RESOURCE USAGE 

 Discussion 

You can view resource allocation and quickly identify overallocated resources in the 

Resource Usage view. This view displays each resource name and the list of tasks to 

which each resource is assigned, as well as the sum of the work assignments. 

 

By default, the Resource Usage view uses a timescale similar to the Gantt Chart 

view, but it shows number values instead of bars. These numbers are the scheduled 

amount of work for each resource for the duration of the task(s) to which they are 

assigned. If a resource is overallocated, the resource name and numbers appear in red. 

You can add fields to display the actual work already completed by the resource 

(Actual Work) and the total work accumulated for the resource (Cumulative Work). 

You can also add fields to view the amount of work for which the resource is 

overallocated (Overallocation), the cost for all tasks assigned to the resource (Cost), 

and the amount of time remaining that the resource is available (Remaining 

Availability). 

 
The Resource Usage view 

 

  

 
Formatted numbers that are too wide to fit into a cell may 

appear as a series of pound signs (#). To view an entire 

number, you can increase the column width by dragging the 

right column border in the column heading to the desired 

width. 
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You can also display and hide details by right-clicking in the 

timescale pane on the right and selecting or deselecting the 

desired detail. 

  
 

 Step-by-Step 

From the Student Data directory, open HOUSE8.MPP. 

View resource usage and overallocation details 

 

Switch to the Resource Usage view. Use the vertical scroll bar as necessary to display 

the 16 Backhoe Operator resource, which appears in red, indicating that it is 

overallocated. Select the 16 Backhoe Operator resource. 

 

Steps Practice Data 

1. Scroll the timescale to display the 

hourly breakdown for the desired 

task(s).  

The hourly breakdown appears with 

overallocations displayed in red. 

Click  to scroll to the 

week of Aug 6, 06 

2. If necessary click the Resource Usage 

Tools contextual tab  

Click the Resource Usage 

Tools contextual tab 

3. Select the field you want to display. 

The desired field appears in the right 

pane of the Resource Usage view. 

Click    Overallocation 

 

View the T (Tuesday) field for the week of Aug 6, ‘06 and notice that the Backhoe 

Operator is overallocated by 16 hours. 

 

Practice the Concept: Display the Remaining Availability field. Scroll as necessary 

to see that the Backhoe Operator resource is available for sixteen hours on Monday 

of the week of Aug 13, 06. 

 

Hide the Remaining Availability field by right-clicking in the right pane and 

deselecting the Remaining Availability command. Hide the Overallocation field as 

well. 
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RESOLVING CONFLICTS BY INCREASING UNITS 

 Discussion 

One method of solving overallocation problems with a resource is to increase the 

maximum units assigned to the task, if possible. For example, if your project shows 

that the Electrician resource is overallocated during the seventh month of the project, 

additional electricians could be hired for that one month period. 

 

 Step-by-Step 

Resolve resource conflicts by increasing units. 

 

If necessary, switch to the Resource Usage view. 

 

Scroll as necessary to view the 2 Painter resource during the week of Oct 22, 06. 

Notice that the resource name and work values are in red, indicating that the resource 

is overallocated. 

 

Steps Practice Data 

1. Double-click the overallocated 

resource to which you want to add 

units. 

The Resource Information dialog box 

opens. 

Double-click the 

2 Painter resource in the 

Resource Name column 

2. Select the General tab. 

The General page appears. 

Click the General tab, if 

necessary 

3. Select the Units field in the Resource 

Availability table. 

The Units field is selected and a spin 

box appears in the field. 

Click in the Units field 

4. Enter the new unit value in the Units 

field in the Resource Availability 

table. 

Click  Units to 400% 

5. Select OK. 

The Resource Information dialog box 

closes and the resource no longer 

appears in red  

Click OK 

 

Notice that the Painter resource no longer appears in red since you added a painter to 

complete the task. 
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LEVELING A RESOURCE 

 Discussion 

If multiple tasks have been scheduled at the same time, resource overallocation can 

result. The resources can be spread out over a longer period of time or tasks can be 

delayed or split to lessen the demand for the resources. This process is called resource 

leveling, which is one way to resolve resource conflicts. 

 

In most resource views, overallocated resources appear in red. In resource views with 

an indicator column, an indicator appears to let you know that a resource is 

overallocated and should be leveled. The indicator appears in the Indicators column 

in the shape of a yellow diamond containing a black exclamation point. 

 

You can level one resource at a time or all project resources at once when you are in a 

resource view. If you are not in a resource view when you level resources, all 

resources are leveled and you are not prompted to choose which resources you want to 

level. 

 

You can level resources manually or automatically as tasks are added to the schedule. 

In addition, Microsoft Project can search for overallocations in a specified time 

period, such as daily or weekly, so that you can level resources in a specified time 

frame, such as on a particular day or month. You can set leveling options to control 

the way in which multiple resources are leveled and specify if the project finish date is 

affected by leveling. You can also set options to control the leveling of multiple 

resources assigned to the same task and to allow tasks to be split. 

  
The Resource Leveling dialog box 

 

  

 
If you try to level a resource and leveling is not an option, a 

Microsoft Project dialog box will open, informing you of any 

problems and providing alternatives to leveling. 
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 Step-by-Step 

Level a resource. 

 

If necessary, switch to the Resource Usage view.  

 

Scroll as necessary and notice that the 9 Carpenter resource appears in red with a 

leveling indicator to its left, indicating that it is overallocated. 

 

 

 

Notice that the Carpenter resource no longer appears in red and that the leveling 

indicator disappeared. 

SPECIFYING LEVELING TIMEFRAMES 

 Discussion 

When you level resources, you can use the default time settings or specify your own. 

By default, Microsoft Project looks for overallocations on a Day by Day basis; 

meaning that if a resource is overallocated, Microsoft Project will level the resource 

only if the assigned tasks cannot be completed in one day. Therefore, if the resource is 

assigned two tasks on the same day and one requires two hours and the other requires 

three hours, the resource will not be leveled. On the other hand, if both tasks require 

six hours, the resource will be leveled. You can change the time period in which 

Microsoft Project looks for overallocations to Minute by Minute, Hour by Hour, 

Week by Week, or Month by Month. 

Steps Practice Data 

1. Select the resource(s) you want to 

level if you are only leveling selected 

resources. 

The desired resource is selected. 

Click the 9 Carpenter 

resource in the Resource 

Name column 

2. Select the Resource tab. 

The Resource ribbon appears. 

Click the Resource tab 

3. Verify that the Manual option is 

selected under Leveling calculations. 

 

Click   

and verify  Manual is 

selected 

4. Select the Level Resources button. 

The Resource is leveled according to 

the options set 

Click  
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In addition, by default, Microsoft Project levels an entire project unless you indicate 

otherwise. You can specify a timeframe in which you want Microsoft Project to level 

resources. Therefore, if your project lasts six months, you can set Microsoft Project to 

only level overallocated resources in a particular month or week, on a specific day, 

etc. 

 

 Step-by-Step 

Specify leveling timeframes. 

 

Switch to the Resource Sheet view. Notice that both the 16 Backhoe Operator and 

20 Backhoe resources appear in red, indicating that they are overallocated. Switch to 

the Gantt Chart view and scroll to view the week of Aug 6, 06. Notice that both 

resources are assigned to two tasks (12 Dig Foundation and 13 Smooth Foundation) 

that overlap. 

 

Steps Practice Data 

1. Select the Resource tab. 

The Resource ribbon appears. 

Click the Resource tab 

2. Verify that the Manual option is 

selected under Leveling calculations. 

 

Click   

and verify  Manual is 

selected 

3. Select the Look for overallocations 

on a <timeframe> basis list. 

A list of timeframe options appears. 

Click Look for 

overallocations on a 

<timeframe>  basis  

4. Select the desired time period. 

The desired timeframe appears in the 

Look for overallocations on a 

<timeframe> basis box. 

Click Month by Month 

5. Select the desired option under 

Leveling range for ‘file name’. 

The desired option is selected. 

Click  Level 

6. Select the From list. 

A calendar appears. 
Click From   

7. Select the desired date. 

The desired date appears in the From 

box. 

Enter From: 8/6/2006  

To: 8/13/2006 

8. Click OK to accept the changes. 
Click  
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Steps Practice Data 

10. Select Level Now. 

The Resource Leveling dialog box 

closes and the overallocated resources 

meeting the specified criteria are 

leveled. 

Click  

 

Notice that the two tasks still overlap. Based on the options you selected in the 

Resource Leveling dialog box, only tasks with more work than could be completed in 

a month (Month by Month) were leveled. 

 

Practice the Concept: Open the Leveling Options dialog box again, change the time 

period to Day by Day, and select Level Now. Notice that the second task (13 Smooth 

Foundation) is delayed until the other task (12 Dig Foundation) is finished. Switch 

to the Resource Sheet view and notice that both resources no longer appear in red. 

CHANGING THE LEVELING ORDER 

 Discussion 

When Microsoft Project levels resources, it uses a set of rules to determine the order 

in which the tasks will be delayed. When more than one task will be delayed, you 

have three selections to determine the order in which the tasks are delayed. In the 

Resource Leveling dialog box, you can display the Leveling order list under 

Resource overallocations and select one of the following options: ID Only; 

Standard; Priority, Standard. 

 

When the ID Only option is selected, Microsoft Project chooses the task with the 

higher ID number as the task to delay. The Standard option is the default order of 

leveling. With the Standard option, Microsoft Project uses five criteria to determine 

which task should be leveled first. The order of these criteria is as follows: 

predecessor relationships, slack, dates, priority, and constraints on the task. The 

Priority, Standard option is the same as the Standard option, but the order of the 

criteria changes. The priority is the first determining factor, followed by predecessor 

relationships, slack, dates, and constraints. 

 

Priority refers to the level of importance you attach to a task regarding leveling. You 

can assign a priority level from 0 through 1000, with 1000 indicating that the task is 

not to be leveled. By default, all tasks are assigned a priority level of 500. Slack refers 

to the amount of time a task can be delayed before it impacts the dates of another task 

or the project finish date. 

 

You can also set other leveling options in the Resolving overallocations area to 

control the way Microsoft Project levels resources. If you want Microsoft Project to 

level tasks without affecting a project’s finish date, you can select the Level only 

within available slack option, which is not selected by default. However, this option 
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does not allow Microsoft Project much flexibility in leveling resources. If you want 

Microsoft Project to level overallocated resources assigned to the same tasks as other, 

non-overallocated resources, you can select the Leveling can adjust individual 

assignments on a task option, which is selected by default. If you want Microsoft 

Project to split a task so that a resource can perform the task later, you can select the 

Leveling can create splits in remaining work option, which is also selected by 

default. 

 Step-by-Step 

Change the leveling order. 

Steps Practice Data 

1. Select the Resource tab. 

The Resource ribbon appears. 

Click the Resource tab 

2. Open Leveling Options dialog 

 
Click    

3. Select the Leveling order list under 

Resolving overallocations. 

A list of delay options appears. 

Click Leveling order  

4. Select the desired delay option. 

The desired delay option appears in 

the Leveling order box. 

Click Priority, Standard, 

then Click OK 

5. Select OK. 

The project is leveled utilizing the new 

leveling settings. Click  

 

Practice the Concept: Change the leveling order back to the default, which is 

Standard. 

LEVELING BY ENTERING A DELAY AMOUNT 

 Discussion 

If the source of the overallocation for a resource is because you scheduled more than 

one task at the same time, one or more of the tasks can be delayed in order to 

distribute the demand on the resource. You can view the Gantt chart to see where 

conflicts exist and determine the number of days you need to delay a task. You can 

allow Microsoft Project to delay the task when you use the Resource Leveling dialog 

box, or you can choose to delay the task yourself. 

 

When you delay a task, you enter the desired delay amount in the Resource 

Allocation view. The Resource Allocation view is a combination view. The top pane 
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displays the Resource Usage view and the bottom pane displays the Leveling Gantt 

view. You enter the delay amount in the Leveling Gantt view in the Leveling Delay 

field. This field is always based on elapsed time. Therefore, if you enter a 7 in this 

field, a value of 7 edays would be entered by Microsoft Project, indicating seven 

elapsed days. If you are using the Standard project calendar, seven elapsed days 

includes Saturday and Sunday.  

 
The Resource Allocation view 

 

 Step-by-Step 

Level a resource by entering a delay amount. 

 

If necessary, switch to the Resource Sheet view and notice that the 1 Laborer 

resource appears in red, indicating that it is overallocated. 

 

Use the More Views dialog box to switch to the Resource Allocation view. Drag the 

vertical split bar to the right until the Leveling Delay field appears in the bottom pane. 

Scroll the top pane as necessary to view the 1 Laborer resource that appears in red. 

Select the Laborer resource to display the tasks to which it is assigned in the bottom 

pane. Select the 19 Install Doors task in the bottom pane and use the Scroll to Task 

button to view the task bars for the 19 Install Doors and 20 Install Windows tasks. 

Notice that the tasks overlap. 
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Steps Practice Data 

1. Select the Leveling Delay field in the 

bottom pane for the task you want to 

delay. 

The Leveling Delay field for the 

desired task is selected and a spin box 

appears in the field. 

Click the Leveling Delay 

field for the 20 Install 

Windows task 

2. Enter the desired delay amount. 

The desired amount appears in the 

Leveling Delay field. 

Type 2 

3. Press [Enter]. 

The delay is entered and the resource 

is no longer overallocated. 

Press [Enter] 

 

Notice that the Laborer resource no longer appears in red. 

CLEARING LEVELING 

 Discussion 

There may be times when you have leveled a particular resource or an entire project 

and are still not satisfied with the results. You can reverse the leveling action 

immediately after leveling a resource using the Undo feature or the Clear Leveling 

button in the Resource Leveling dialog box. When you use the Clear Leveling button, 

you have the option to clear the leveling for the entire project or the selected task. In 

addition, you can remove a delay by entering a 0 in the Leveling Delay field in the 

Leveling Gantt view. 

 

 Step-by-Step 

Clear leveling. 

 

If necessary, switch to the Resource Allocation view and view the tasks for the 1 

Laborer. 

 

Steps Practice Data 

1. Select the task associated with the 

leveling action you want to remove. 

The desired task is selected.  

Click the 20 Install 

Windows task in the 

bottom pane 
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Steps Practice Data 

1. Select the Resource tab. 

The Resource ribbon appears. 

Click the Resource tab 

2. Select the Clear Leveling command. 

The Resource Leveling dialog box 

closes and the Clear Leveling dialog 

box opens. 

Click Clear Leveling... 

3. Select the Entire project or Selected 

tasks option. 

The desired option is selected. 

Click  Selected tasks, if 

necessary 

4. Select OK. 

The Clear Leveling dialog box closes 

and the leveling of the entire project or 

selected tasks is cleared. 

Click OK 

 

Notice that the 1 Laborer resource appears in red again, indicating that it is 

overallocated, and the delay amount for the 20 Install Windows task changed back to 

0. 

 

Switch to the Resource Sheet view. 

SPLITTING A TASK 

 Discussion 

Another way that you can address overallocations is to split a task. Splitting a task is 

helpful when you have two tasks that overlap and use the same resource. For example, 

you could split the first task where the second task begins and then resume work on 

the first task when the second task is complete. 

 

You may also need to split a task if part of the task occurs on one day and part on 

another, non-consecutive day. For example, it will take a painter two days to paint a 

room. On the first day, the painter applies the first coat. Two days later, on the second 

day of the task’s duration, the painter applies the second coat. In this situation, you 

could split the task to show that the painter works on the task on two non-consecutive 

days. This type of scheduling would enable the painter to work on other tasks between 

the first day and second day of the split task. 

 

As you track your project and mark tasks complete, you may also need to split tasks 

that are partially complete. You can then reschedule the unfinished work for a later 

time.  
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Splitting a task 

 

  

 
To remove a split, drag one portion of the split task bar until it 

touches another portion of the split bar. 

  
 

 Step-by-Step 

Split a task. 

 

If necessary, switch to the Resource Sheet view. Notice that the 6 Contracting 

Specialist resource appears in red, indicating it is overallocated. 

 

Switch to the Gantt Chart view. Scroll as necessary to view the task bars for the 

6 Obtain Permits and 7 Obtain Bids tasks. Notice that the tasks overlap. 

 

Steps Practice Data 

1. Click the Split Task button in the 

Schedule group on the Task tab.  

 
Click  
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Steps Practice Data 

2. Point to the area of the task bar where 

you want the split to begin. 

The mouse pointer changes into a split 

bar with an arrow and the ScreenTip 

reflects the day and date where the 

mouse pointer is resting. 

Point to the task bar for 

the 6 Obtain Permits task 

and rest the mouse pointer 

where the ScreenTip 

displays Tue 7/11/06 

3. Drag the mouse button from the start 

of the split to the location where you 

want work on the task to begin again. 

The task is split at the desired location 

and an ellipsis indicates the split. 

Drag from the Tue 

7/11/06 position until the 

Start date in the 

ScreenTip is Thu 7/13/06 

 

Switch to the Resource Sheet view and notice that the 6 Contracting Specialist 

resource no longer appears in red. 

 

Remove the split by dragging the second half of the split task bar, which begins on 

7/13/06, until it touches the first part of the split task bar. 

 

Change the relationship of the 6 Obtain Permits and 7 Obtain Bids tasks to Finish-

to-Start and remove the lag time. 

CHANGING LEVELING TO AUTOMATIC 

 Discussion 

When leveling for resources is set to automatic, Microsoft Project levels tasks as soon 

as an overallocated resource is detected. This type of leveling takes place as tasks are 

entered into the project. While allowing Microsoft Project to level tasks automatically 

can be helpful, you should remember that you will not know when overallocations 

exist. For this reason, you may not want to use the automatic feature as it prevents you 

from seeing overallocations and deciding on the best way to address them. 

 

The first time you select the Automatic option, you also need to set any other leveling 

options as desired in the Resource Leveling dialog box. In addition, if you are in a 

resource view, you will be prompted to level the entire pool or selected resources 

when you choose the Automatic option. The next time an overallocation occurs, the 

resource is automatically leveled and you will not be prompted to make any 

selections. 

 

 Step-by-Step 

Change leveling to automatic. 
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Switch to the Resource Sheet view. Select the 1 Laborer resource, which appears in 

red, indicating that it is overallocated. 

 

Steps Practice Data 

1. Select the Resource tab. 

The Resource ribbon appears. 

Click the Resource tab 

2. View the leveling options for the 

project. 

 

Click    

3. Select the Automatic option under 

Leveling Calculations. 

The Automatic option is selected. 

Click  Automatic 

4. Change any other leveling options as 

desired. 

The desired leveling options are 

changed. 

Click  Level entire 

project under Leveling 

range for ‘file name’ 

5. Select OK. 

The Resource Leveling dialog box 

closes, the automatic leveling feature 

is enabled, and the Level Now dialog 

box opens. 

Click OK 

6. Select the Entire pool or Selected 

resources option. 

The desired option is selected. 

If necessary Click  

Selected resources,  

7. Select OK. 

The Level Now dialog box closes and 

the entire pool or selected resource is 

leveled. 

Click OK 

 

Notice that the 1 Laborer resource no longer appears in red. 

 

Open the Leveling Options dialog box again and switch the leveling setting back to 

Manual. Select OK to close the dialog box. Request Permits 

SETTING TASK LEVEL PRIORITY 

 Discussion 

By default, all tasks have a priority level of 500, which is a medium level priority. The 

higher the priority level assigned to a task, the less likely it is that the task is selected 

for delay. Therefore, a task with a priority of 900 is less likely to be delayed than a 



Project - Lvl 2 Lesson 3 - Adjusting Resources 

 Page 39 

 

task with a priority of 400. You can also assign a priority of 1000 to a task, which 

indicates that the task is not to be leveled. 

 
Setting a task level priority 

 

  

 
If you are working with multiple projects, you can set project 

priority levels to indicate how you want the tasks in each 

project leveled in relation to one another. 

  

 
You can also assign a task priority in a task view by double-

clicking the task to open the Task Information dialog box. 

  
 

 Step-by-Step 

Set task level priority. 

 

Switch to the Resource Allocation view. 

 

Steps Practice Data 

1. Select the resource name in the top 

pane associated with the task you want 

to prioritize. 

The desired resource is selected. 

Scroll as necessary and 

click the 6 Contracting 

Specialist resource in the 

Resource Name column 

2. Double-click the task in the bottom 

pane you want to prioritize. 

The Task Information dialog box 

opens. 

Double-click the 

5 Request Permits task in 

the bottom pane 
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Steps Practice Data 

3. Select the General tab. 

The General page appears. 

Click the General tab, if 

necessary 

4. Select the number in the Priority spin 

box. 

The current priority is selected. 

Double-click the number 

in the Priority spin box 

5. Enter the desired priority. 

The desired priority appears in the 

Priority box. 

Type 1000 

6. Select OK. 

The Task Information dialog box 

closes and the task priority level is set. 

Click OK 

 

Remove the window split and switch to the Gantt Chart view. Change the 

relationship of the 4 Request Bids and 5 Request Permits tasks to Start-to-Start. 

Switch to the Resource Sheet view to see that the Contracting Specialist resource, 

which is assigned to both tasks, appears in red. 

 

Select the Contracting Specialist resource,  select Level Now, and level the selected 

resources only. Notice that a Microsoft Project warning box opens, advising you that 

Microsoft Project cannot resolve the overallocation. This occurs since the 1000 

priority level assigned to the Request Permits task indicates that the task cannot be 

leveled. Select Stop to stop the current operation and close the dialog box. 

Close HOUSE8.MPP. 

 



 

 

LESSON 4 -  
WORKING WITH THE CRITICAL PATH  

In this lesson, you will learn how to: 

 View the critical path  

 View slack  

 Shorten the critical path  

 Assign overtime to a task  
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VIEWING THE CRITICAL PATH 

 Discussion 

The critical path of a project consists of the tasks that affect the finish date of the 

project. These tasks are called the critical tasks. If one of the tasks on the critical path 

finishes late or early, the project finishes late or early. 

 

Before you begin your project, it is important to be aware of which tasks are on the 

critical path. Then, as you evaluate the progress of the project, you can adjust tasks on 

the critical path as needed. 

 

You can use a filter to view the critical path. Applying a filter displays only the 

critical tasks; the noncritical tasks are hidden. 

 

Applying the Detail Gantt view is another way of viewing critical tasks. In this view, 

the Gantt bars for critical tasks appear in red and noncritical tasks appear in blue. 

 

 Step-by-Step 

From the Student Data directory, open HOUSE10.MPP. 

View the critical path. 

 

If necessary, switch to the Gantt Chart view. 

 

Steps Practice Data 

1. Select the View tab on the Ribbon and 

locate the Data group.  This is where 

filtering options appears. 

Locate the Filter option 

 

2. Select Critical. 

Only the critical tasks appear in the 

view. 

Change the filter drop 

down from [No Filter] to 

Critical 

 

Notice that the critical path begins with the 10 Build Structure task. 

 

Click the drop-down again and choose Clear Filter.  

 

Apply the Detail Gantt view. Scroll the tasks to notice the blue and red Gantt bars. 

The 16 Frame House task is a critical task, and therefore appears in red. Return to the 

Gantt Chart view. 
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VIEWING SLACK 

 Discussion 

Noncritical tasks can start late without affecting other tasks or the project finish date. 

These tasks have slack, which is the amount of time a task can be delayed without 

affecting other tasks. It is helpful to know where slack exists in the schedule. You can 

use slack to adjust a plan so that a project finishes on schedule. For example, you 

might be able to move a task with slack to a later start date to free a resource. You can 

then assign that resource to a critical task to shorten its duration. 

 

By default, critical tasks have slack that is less than or equal to zero days. If your 

critical tasks can have a different amount of slack, you can change this number in the 

Options dialog box. 

 

Microsoft Project provides two types of slack: free and total. Free slack is the amount 

of time a task can be delayed without delaying the start date of another task. Total 

slack is the amount of time a task can be delayed without delaying the finish date of 

the project. Microsoft Project calculates slack by comparing the difference between 

the late start date and the scheduled start date with the difference between the late 

finish date and the scheduled finish date. The smaller of the two differences is the 

total slack. If the total slack value is negative, the task’s duration is too long for its 

successor to start at the time designated by a constraint (e.g., a task must start on 

xx/xx/xx). 

 

You can view slack in the Detail Gantt view. In the left pane, you can view the free 

and total slack amounts. In the right pane, you can view free slack, represented by the 

slack bars that join the task bars. 

 

Deadline dates affect the slack amounts for noncritical tasks, but do not affect these 

amounts for critical tasks. If you have a deadline date set for a task that is not critical, 

the Total Slack is the amount of time a task can slip and still meet the deadline date. 

All tasks linked to the task with the deadline date will also be affected by this date. 

For example, the first three tasks in your task list are linked. The third task has a 

deadline date that is two days later than the planned finish date. This task will display 

a total slack value of 2 days. Likewise, the first and second task will reflect slack 

values based on the deadline date, not the project finish date. If you remove the 

deadline date, the noncritical tasks will reflect the true total slack value, which is the 

number of days the task can slip without affecting the project finish date.  
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Viewing slack 

 

  

 
To change the default amount of slack time for critical tasks, 

open the Options dialog box by selecting the File tab and 

clicking Options. Then, select the Advanced page and change 

the slack time in the Tasks are critical if slack is less than or 

equal to ____ days spin box. 

  

 
You may want to be sure you are viewing the most recent 

calculations of slack time by pressing the [F9] key to force 

calculation. 

  
 

 Step-by-Step 

View slack. 

 

Switch to the Detail Gantt view. 

 

Drag the split bar as far to the right as possible. 

 

Steps Practice Data 

1. Select the View tab. 

The View ribbon appears. 

Click View 

2. Click the Tables button  

The Table list appears. 
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Steps Practice Data 

3. Select the Schedule table from the list. 

The format of the view changes to 

display the Schedule table, which 

contains the Free Slack and Total 

Slack columns. 

Click Schedule 

 

Scroll as necessary to view the Free Slack and Total Slack columns. Notice that most 

of the tasks and subtasks for 10 Build Structure and 23 Build Infrastructure have 

free and total slack amounts of 0 days, indicating they are tasks on the critical path. 

 

Notice that the 3 Draft Proposal task has a total estimated slack amount of 1 day; this 

is the amount by which the task can slip and still meets it deadline date. View the 

5 Request Permits task and notice the total slack amount is 95 days. Use the 

Advanced page in the Task Information dialog box to apply a deadline date of 

7/11/06 to the task. Notice that the total slack amount changed to 2 days, which is the 

amount by which the task can slip and still meet its deadline date. 

 

Drag the split bar to the left. Scroll the Detail Gantt view as necessary to view the 

free slack bars in the right pane. 

SHORTENING THE CRITICAL PATH 

 Discussion 

After you create a project, you can evaluate it to see if it still meets your objectives 

before you actually start. For example, you may notice that tasks on the critical path 

will take too long to complete. To solve this problem, you could shorten the critical 

path in order to finish the project by the finish date. You can shorten the path before 

you begin a project, or as a project progresses and tasks are not completed as planned. 

 

You can use several methods to shorten the critical path, including decreasing task 

durations, adding lead time or resources, scheduling overtime, or increasing resource 

work hours. When you shorten the critical path, however, you should be aware that 

the cost of the project usually increases and may cause an overallocation of some 

resources. 

 

Each option for shortening the critical path has its own disadvantages. One 

disadvantage would be that it may be unrealistic to decrease the duration of a critical 

task because it cannot be completed in a shorter timeframe. Another disadvantage 

would be that adding lead time between critical tasks, which does not increase costs, 

could overallocate resources. If a task is effort-driven, you could add resources to it to 

shorten the task duration; however, you may not be able to find available resources 

and it could increase costs. Scheduling overtime can keep tasks on track if they are 

effort-driven; however, this would increase costs. If you increase the working hours 

for the resource, the critical tasks would finish sooner; however, this would also 
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increase costs. All of these options are available to you to keep your project on 

schedule, but you will need to determine which options are the most effective and 

appropriate for your particular situation. 

 

ASSIGNING OVERTIME TO A TASK 

 Discussion 

Assigning overtime to resources is one way to shorten the duration of a task because 

the same amount of work can be completed in a shorter amount of time. You can 

assign overtime to tasks before you begin a project to eliminate any possible 

overallocations. You may also need to assign overtime as your plan progresses if it is 

not going according to schedule. 

 

You can assign overtime work in the Task Form view with the Resource Work 

format applied. When you assign overtime, you enter the overtime hours in the Ovt. 

Work field. You do not change the value in the Work column since the total amount 

of work for the task is the same. By adding overtime, you are telling Microsoft Project 

that some of the work will be performed outside of the normal working hours in the 

calendar. Microsoft Project subtracts the overtime work from the total work and 

shortens the duration of the task to reflect the amount of work to be completed during 

regular working hours.  

 
Assigning overtime to a task 
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 Step-by-Step 

Assign overtime to a task. 

 

Switch to the Gantt Chart view. Split the view to display the Task Form view in the 

bottom pane. 

 

Steps Practice Data 

1. Select the task in the top pane 

associated with the resource to which 

you want to assign overtime. 

The desired task is selected. 

Scroll as necessary and 

click the 20 Install 

Windows task 

2. Select the bottom pane. 

The bottom pane is selected. 

Right click anywhere in 

the bottom pane 

3. Select the Work command. 

The bottom pane changes to the 

Resource Work format. 

Click Work 

4. Select the Ovt. Work field in the 

bottom pane for the desired resource. 

The Ovt. Work field is selected. 

Click the Ovt. Work field 

for the Laborer resource 

5. Enter the number of overtime hours. 

The number of overtime hours are 

entered. 

Type 8 

6. Select OK. 

Overtime is assigned to the selected 

resources. 

Click OK 

 

Notice that the duration of the 20 Install Windows task changed from 4 days to 3.5 

days. Remove the window split. 

Close HOUSE10.MPP.  

 





 

 

LESSON 5 -  
WORKING WITH BASELINES  

In this lesson, you will learn how to: 

 Use baselines  

 Use baseline tables  

 Save a project baseline  

 Use the Tracking Gantt  

 Update a project baseline  

 Update tasks in a baseline  

 Save additional baselines  

 Save a project interim plan  

 Clear a baseline  
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USING BASELINES 

 Discussion 

A baseline is a copy of the scheduled dates, cost, and work data that is used to track 

the progress of a project by comparing it against the current schedule. It is usually a 

copy of the final plan just before the work on a project begins. You must remember to 

create the baseline copy before you start entering actual data. When you enter actual 

data, you are recording the schedule as it happens and it may no longer reflect the 

original plan. 

 

When the baseline is saved, the current dates, work, and cost data are used for 

comparison with the actual progress of the project. Before deciding on the final 

baseline, everyone involved in the project should know what is expected of them and 

agree to perform according to the plan. In addition, necessary approval should be 

obtained for the required resources. 

 

USING BASELINE TABLES 

 Discussion 

When you first save a baseline, the baseline data and the information in the current 

schedule will be identical; however, as you track your progress, the actual data could 

vary from the original plan. Microsoft Project provides three tables that allow you to 

compare the baseline with the current schedule: Variance, Cost, and Work. 

 

The Variance table displays information regarding dates only. This table displays the 

start and finish dates and baseline start and finish dates, along with the start and finish 

variances. Until actual information is entered, the start and finish dates display the 

anticipated start and finish dates. Once the project starts and you enter actual 

information, the Start and Finish fields display the actual dates. 

 

The Cost table displays cost information, including the total cost, baseline, actual, and 

remaining cost information. It also displays the variance between the total cost and 

baseline cost. Tasks that have not started display an actual cost of $0 and a remaining 

cost that equals the total cost. Once the project starts and you enter actual information, 

the Actual field displays the actual costs. If costs vary from the plan, the Variance 

field will display the difference. 

 

The Work table displays information regarding the number of hours of work for each 

task. It displays the total work, baseline, actual, and remaining work values. It also 

displays the variance between the total work and baseline values, and the percentage 

complete for each task. Tasks that have not started display 0 hours of actual work and 

the remaining work amount equals the total work value. Once the project starts and 
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you enter actual information, the Actual field will display the actual hours of work. 

Completed tasks display 100% in the % W. Comp. field. 

 

SAVING A PROJECT BASELINE 

 Discussion 

The baseline plan is the original project plan you save to track progress. The baseline 

plan includes task start and finish dates, as well as resource and cost information. You 

can use the baseline to compare with the actual data recorded as your plan progresses. 

This information may also be useful when the project is completed, should you have a 

similar project in the future. 

 

When you create a baseline plan, Microsoft Project copies the plan information for 

dates, work, and cost entered from the current fields into the baseline fields. Baselines 

can be saved at any time, but it is a good idea to wait until you have completely 

entered the plan. If you need to change the plan later, you can save the baseline again 

or save an interim plan. 

 
Saving a project baseline 
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 Step-by-Step 

From the Student Data directory, open HOUSE14.MPP. 

Save a project baseline. 

 

In the Gantt Chart view, apply the Variance table and drag the split bar as far right 

as possible to view the Baseline Start and Baseline Finish fields. Notice that there 

are no baseline start and finish dates yet, as you have not saved the baseline. 

 

Steps Practice Data 

1. Select the Project tab Click Project 

2. Click the Set Baseline button drop-

down arrow. 

The Save Baseline pane opens.  

3. In the Set Baseline dialog box, select 

the Set Baseline option and select OK. 

 The project baseline is saved and the 

baseline date and time appear in the 

Save Baseline pane. 

Click set Baseline, and 

click OK 

 

Notice that the Baseline Start and Baseline Finish fields now contain dates which are 

the same as the current start and finish dates as you have not entered any actual data 

yet. Apply and view the Work table and then the Cost table. Notice that all the 

baseline data matches the current data at this point. 

 

USING THE TRACKING GANTT 

 Discussion 

The baseline saves the start and finish dates for project tasks. As you make changes to 

the project that affect the original schedule, such as insert new tasks or change task 

durations, task dates may no longer match the baseline dates. The Tracking Gantt 

view displays any changes that have affected the original schedule saved with the 

baseline. 

 

The Tracking Gantt chart is similar to the Gantt chart, but it has paired bars for each 

task. The lower bar displays the baseline start and finish dates and the upper bar 

displays the scheduled or actual start and finish dates (depending on whether or not 

the task has started). When you first save a baseline, both bars line up. As you refine 
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your project plan, the bars will no longer align if your changes affect the starting and 

ending dates of the tasks.  

 
The Tracking Gantt view 

 

  

 
The Tracking Gantt view displays Gantt bars for critical 

tasks in red. 

  
 

 Step-by-Step 

Use the Tracking Gantt view. 
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Steps Practice Data 

1. Select the View tab. 

The View Ribbon appears. 

Click View, then  click the 

Gantt Chart drop down 

arrow in the upper left as 

shown below 

2. Select the Tracking Gantt command. 

The Tracking Gantt view appears. 

 

 

With the view tab still selected, click the entire project button to zoom the Gantt chart 

view so that the entire project is displayed on the right-hand side of your screen.  

Notice that all the blue and red bars line up with the gray bars underneath. 

UPDATING A PROJECT BASELINE 

 Discussion 

As you make changes to the original plan, you can update the project’s baseline. 

Updating the baseline for the entire project overwrites all the data in the current 

baseline with the new information. 

 Step-by-Step 

Update a project baseline. 

 

If necessary, display the Tracking Gantt view. 

 

Insert a new task above the 5 Request Permits task. Name the task Review Bids and 

give the task a duration of 3 days. Then, assign the Contracting Specialist to the 

task. Scroll to view the Tracking Gantt bar for the new task, 5 Review Bids. There is 

no gray baseline bar for the new task. Notice the spread between the baseline (gray) 

and scheduled (blue) tracking bars for tasks 6 through 9. 
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Steps Practice Data 

1. Select the Project tab Click Project 

2. Click the Set Baseline button drop-

down arrow link. 

The Save Baseline pane opens.  

3. In the Set Baseline dialog box, select 

the Set Baseline option and select OK. 

 The project baseline is saved and the 

baseline date and time appear in the 

Save Baseline pane. 

Click set Baseline, and 

click OK 

4. If necessary, select The entire project 

option. 

The entire project option is selected. 

Click  The entire 

project, if necessary, and 

then Click OK. 

5. You may be prompted as to whether 

you wish to overwrite the existing 

baseline. 

The current project baseline is 

updated. 

Click Yes if prompted to 

overwrite the existing 

baseline 

 

Notice that all the Tracking Gantt bars line up.  

 

Practice the Concept: The schedule change means that the 6 Request Permits task 

will not meet its deadline date. Add the Surveyor to the 5 Review Bids task and 

accept the smart tag option to reduce the duration.  Set the baseline again, and select 

OK. Select Yes to overwrite the current baseline. 

UPDATING TASKS IN A BASELINE 

 Discussion 

When you save a baseline, the default option makes a copy of the baseline for the 

entire project; however, you can also save a baseline of selected tasks. Saving a 

baseline of selected tasks is helpful when you have saved a baseline of the entire 

project and then realize you need to adjust certain incorrect task information. You can 

revise the tasks and then update the original baseline for those tasks only. 

 

In addition, during the life of the project you may need to add tasks after the baseline 

has been saved. You can select those new tasks and add them to your original plan by 

updating the original baseline. 
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You can also add selected tasks to a baseline using the Set 

Baseline dialog box. Select the tasks you want to add, and then 

select the Project tab, the Set Baseline drop down, and then 

the Selected tasks option. Select OK and then Yes to 

overwrite the current baseline. 

 

 Step-by-Step 

Update tasks in a baseline. 

 

Switch to the Gantt Chart view, apply the Cost table, and drag the split bar as far 

right as possible. 

 

Notice that the Fixed Cost field for the 6 Obtain Permits task displays $500.00 and 

the Baseline field for this task displays $1,580.00. Change the fixed cost of the 

Obtain Permits task to $400. Notice that the Variance field displays ($100.00). 

 

Add a fixed cost of $25 to the 1 Conduct Site Survey task. Notice that the total cost 

changes from $580.00 to $605.00. The variance is $25.00 

 

Steps Practice Data 

1. Select the Project tab Click  the Project tab 

2. Click the Set Baseline button drop-

down arrow link. 

The Save Baseline pane opens.  

3. In the Set Baseline dialog box, select 

the Set Baseline option and select OK. 

 The project baseline is saved  

Click set Baseline, and 

click OK 

4. Select the Only tasks selected on the 

right option. 

The Only tasks selected on the right 

option is selected. 

Click  for selected 

tasks, then click OK. 

5. You may be prompted as to whether 

you wish to overwrite the existing 

baseline. 

The current project baseline is 

updated. 

Click Yes if prompted to 

overwrite the existing 

baseline 

 

Notice that the Baseline field for the 6 Obtain Permits task changed to $1,480.00 and 

the Variance field changed to $0.00. The variance for the 1 Conduct Site Survey 

task remains at $25.00 since this task was not added to the baseline. 

 



Project - Lvl 2 Lesson 5 - Working with Baselines 

 Page 57 

 

Practice the Concept: Select the 1 Conduct Site Survey task.  Click the Set 

Baseline button. Select the Selected tasks option and select OK. Select Yes to 

overwrite the current baseline. Notice that the variance for the 1 Conduct Site Survey 

task changed to $0.00. 

SAVING ADDITIONAL BASELINES 

 Discussion 

If you are creating a large project plan with many phases, you may want to save a 

separate baseline as you create or finish each phase of the plan. Microsoft Project can 

create up to 11 baselines with a project. The first baseline saved is named Baseline. 

Additional baselines can then be saved with the names Baseline 1-10. Each baseline 

saves the task, resource and assignment information for the project. 

 

In addition to saving the duration of each task, baselines also save the start date, finish 

date, and all work and cost information for all tasks and assignments. Baselines also 

save resource information, which includes all work and cost data. 

 

You can update additional baselines the same way you update the main baseline. You 

can save the entire project to an additional baseline or just selected tasks. 

 

 

 Step-by-Step 

Save an additional baseline. 

 

Steps Practice Data 

1.  Select the Project tab Click  the Project tab 

2. Click the Set Baseline button drop-

down arrow link. 

The Save Baseline pane opens.  

3. In the Set Baseline dialog box, select 

the Set Baseline option and select OK. 

 The additional baseline is saved  

Click set Baseline, then 

select Baseline 1 in the 

Set Baseline drop down 

box. 

 

 

Practice the Concept: If necessary, display the Cost table. Change the Fixed Cost 

for the 1 Conduct Site Survey task to 0. Select the 1 Conduct Site Survey task and 

re-open the Set Baseline dialog box.  Select Baseline 1 from the Set Baseline list and 
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select the Selected tasks option. Select OK and then Yes to confirm overwriting the 

baseline. 

 

Select the Variance column, use the [Insert] key to insert a new field, and insert the 

Baseline1 Cost field. Notice that the Baseline1 Cost is calculated without the $25.00 

fixed cost. 

SAVING A PROJECT INTERIM PLAN 

 Discussion 

At certain times during a project, you may want to save only the start and finish dates 

for tasks. This set of dates is referred to as an interim plan. You can create an interim 

plan during the planning stage or after the work has begun. Microsoft Project allows 

you to compare an interim plan with the baseline or current plan to manage your 

project. 

 

Microsoft Project provides ten sets of interim baseline dates that can be used for 

comparison in addition to the original baseline dates (saved in the Baseline 

Start/Finish fields). The interim baseline dates are saved in fields named Start1 

through Start10 and Finish1 through Finish10. You can save the current dates for 

comparison against these baseline dates, which helps you to analyze problem areas 

both during and after the project. These fields are for dates only; work and cost values 

are not included. In addition, no resource or assignment data is saved in an interim 

plan. 

 

In the Set Baseline dialog box, you can specify in which of the ten fields you want to 

hold the saved data. If you select fields that already contain data, the new data 

overwrites the existing data. 
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Viewing interim plan data 

 

 Step-by-Step 

Save a project interim plan. 

 

If necessary, switch to the Gantt Chart view. 

 

Apply the Variance table to the view. Constrain the 2 Develop Blueprints task so 

that it starts no earlier than 6/7/06. Notice that there is now a variance for all the tasks 

affected by the change. 

 

Steps Practice Data 

1. Select the Project tab Click  the Project tab 

2. Click the Set Baseline button drop-

down arrow link. 

The Save Baseline pane opens.  

3. In the Set Baseline dialog box, select 

the Set Baseline option and select OK. 

 The project baseline is saved  

Click set Baseline 

4. Select the Save interim plan option. 

The Save interim plan option is 

selected. 

Click  Save interim 

plan 
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Steps Practice Data 

5. Select the Copy list. 

A list of Start/Finish date options 

appears. 

Click Copy  

6. Select the fields you want to copy. 

The desired fields appear in the Copy 

box. 

If necessary Click  

Scheduled Start/Finish 

7. Select the Into list. 

A list of Start/Finish dates appears. 
Click Into  

8. Select the fields into which you want 

to copy the selected fields. 

The destination fields appear in the 

Into box. 

Click Start1/Finish1 

9. Select the Entire project option. 

The Entire project option is selected. 

Click  Entire project, if 

necessary 

10. Select OK. 

The Set Baseline dialog box closes and 

the interim plan is saved. 

Click OK 

 

Add the Start1 column (width of 12) to the left of the Baseline Start column and the 

Finish1 column (width of 12) to the left of the Baseline Finish column in the current 

view. Notice the difference in the dates due to the one day variance. 

CLEARING A BASELINE 

 Discussion 

After saving baseline data, you may decide that you do not want this data used for 

comparison purposes. If desired, you can clear the baseline and save it at a later time. 

You may also want to clear baseline data if you plan to use a completed project as the 

basis for future projects. 

 

You can clear baseline information for the entire project or for a particular task. In 

addition, you can clear the dates saved in an interim plan as desired. 

 
The Clear Baseline dialog box 
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 Step-by-Step 

Clear a baseline. 

 

If necessary, switch to the Gantt Chart view, apply the Variance table, and drag the 

split bar as far right as possible. 

 

Steps Practice Data 

1. Select the Project tab Click  the Project tab 

2. Click the Set Baseline button drop-

down arrow link. 

The Save Baseline pane opens.  

3. Select the Clear Baseline command. 

The Clear Baseline dialog box opens. 

Click Clear Baseline... 

4. Select the Clear baseline plan or 

Clear interim plan option. 

The desired plan is selected. 

Click  Clear interim 

plan 

5. Select the list for the selected plan. 

A list of plans appears. 

Click Clear interim plan 

 

6. Select the plan you want to clear. 

The plan is selected. 

Click Start1/Finish1 

7. Select the Entire project or Selected 

tasks option. 

The desired option is selected. 

Click  Selected tasks 

8. Select OK. 

The Clear Baseline dialog box closes 

and the baseline information is 

cleared. 

Click OK 

 

Notice that NA now appears in the Start1 and Finish1 fields for the Develop 

Blueprints task. 

 

Select the Develop Blueprints task, if necessary, and open the Set Baseline dialog 

box. Restore the date information by saving the Start1/Finish1 interim plan for the 

selected task. Then, hide the Start1 and Finish1 columns. 

 

Close HOUSE14.MPP. 

 





 

 

LESSON 6 -  
TRACKING YOUR PROGRESS  

In this lesson, you will learn how to: 

 Track progress  

 Update a completed task  

 Set the status date  

 Update a task on schedule  

 Update a task not on schedule  

 View slippage  

 Update projects on schedule  

 Enter the percent complete  

 Enter completed and remaining work  

 Enter actual and remaining durations  

 Enter timephased work values  

 Reschedule uncompleted work  

 Apply progress lines  

 View summary information  
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TRACKING PROGRESS 

 Discussion 

Once the project has started, it is extremely important that you track the progress of 

the individual tasks and the project as a whole. Tracking the project involves entering 

and revising date, cost, and work information; comparing the actual data to the 

baseline plan; and viewing project progress using the various tools provided by 

Microsoft Project. 

 

As a project progresses, you may discover tasks that start early or finish late, as well 

as tasks that cost more or less than expected. As you analyze the task relationships 

that exist, you may want to revise some of them in order to stay on or near schedule. 

You may need to modify tasks in order to meet the projected finish date. As you 

record the actual information into your project, Microsoft Project reschedules the 

tasks that are affected by this data. As you look at the affected tasks, you can take 

corrective action as soon as possible to minimize future problems. You can also look 

at various scenarios using what-if analysis to help you decide on the best solution. 

 

Microsoft Project provides several methods for recording progress. If a task has been 

completed according to schedule, you can mark it 100% complete. Then, all projected 

task information, such as the start and finish dates, duration, work, and costs are 

copied into the corresponding fields for actual data. Therefore, if a task with 16 hours 

in the Work field is completed as scheduled, 16 hours will be copied to the Actual 

Work field, along with the original start and finish dates, duration and costs. If all the 

tasks up to a certain date have been completed as scheduled, you can use that date to 

update multiple tasks at the same time. 

 

You can also record information for tasks in progress by manually entering the 

percentage of the task currently completed or the number of hours the resources have 

already worked. In addition, if the task in progress is on schedule, you can use the 

current date or status date to automatically calculate the partial data. 

 

For tasks that are not on schedule, such as those starting or finishing early and/or late, 

or requiring more or less work, you can enter specific information. For example, you 

can enter the actual start and finish dates or change the actual work and duration 

values. 

 

You should update your project often. These updates allow Microsoft Project to warn 

you of potential problems and help your project get completed as close to the original 

finish date and budget as possible. 
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UPDATING A COMPLETED TASK 

 Discussion 

Microsoft Project allows you to update completed tasks that start and finish on 

schedule. When a task is marked as 100% complete, the corresponding data in the 

Start, Finish, Duration, Work, and Cost fields is automatically copied to the actual 

data fields for the task. In addition, the Gantt chart displays a thin, black bar within the 

thicker task bar called the progress bar. The progress bar indicates the task’s progress 

or its percentage of completion. When a task is marked as 100% complete, the 

progress bar extends the entire length of the task bar. A check mark appears in the 

Indicators column in the Gantt Chart view, indicating that the task is complete.  

 

 
Progress tracking tools on the Task Ribbon 

 

  

 
In addition to marking a task 100% complete, you can use the 

buttons on the Task ribbon to record that a task is 25%, 50%, 

and 75% complete. You can also remove recorded progress by 

marking a task as 0% complete. 

  
 

 Step-by-Step 

From the Student Data directory, open HOUSE15.MPP. 

Update a completed task. 

 

If necessary, switch to the Gantt Chart view. 

 

Display the Task Ribbon. 

 

Steps Practice Data 

1. Select the task you want to mark as 

complete. 

The desired task is selected. 

Click the 1 Conduct 

Survey task, if necessary 
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Steps Practice Data 

2. Click the 100% Complete button  

The task is marked complete and the 

Act. Start and Act. Finish fields are 

completed. 

Click  

 

Notice that a check mark appears in the Indicators field for the task and the progress 

bar extends the full length of the task bar. 

 

Practice the Concept: Mark the 2 Develop Blueprints task as 50% complete. Notice 

that the progress bar only extends half the length of the task bar. 

 

Display the Tracking table and drag the split bar as far right as possible. Notice the 

data that appears in the actual fields for the tasks updated with completed work. The 

1 Conduct Site Survey task is marked as 100% in the % Comp. column. Since the 

task is complete, 0 days appears in the Rem. Dur. (remaining duration) column. 

Notice that the 2 Develop Blueprints task is listed as 50% complete and still has a 

remaining duration of 1 week. 

 

Select the 2 Develop Blueprints tasks and use the 0% button to remove all actual 

data. 

SETTING THE STATUS DATE 

 Discussion 

Some methods of recording progress need a status date when updating tasks. Although 

Microsoft Project uses the current date if you do not enter a status date, it is often 

useful to set separate dates when recording progress. You can use the current date if 

you are entering progress that was completed today, or if a task is proceeding as 

scheduled. If you are late in entering progress information, you may want to select an 

earlier date to reflect the true progress of the tasks you are updating. 

 

It is important to set a status date if you are rescheduling uncompleted work. 

Uncompleted work is automatically scheduled after the status date (or current date if a 

status date has not been set). 

 

The status date is also used when you want to analyze the project status at various 

times throughout its duration. Changing the status date, allows the program to 

compare your baseline information with the date, cost, and work information for a 

date other than the current date. If you do not enter a status date, the current date is 

used for updating tasks and analyzing progress. 

 

The status date is saved with the project file. 
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A dotted line appears in the Gantt chart for the date set in the 

Current date box in the Project Information dialog box. 

  

 
If you deselect the Updating task status updates resource 

status option on the Schedule page of the Options dialog box, 

Microsoft Project will not enter values in the Actual Work 

field when you enter a percent complete or change the actual 

or remaining duration. 

  
 

 Step-by-Step 

Set the status date. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project Ribbon appears. 

Click the Project tab 

2. Select the Project Information 

button. 

 Click    

3. Select the text in the Status date box. 

The text is selected. 

Drag to select the text NA 

in the Status date box 

4. Enter the desired status date. 

The status date appears in the Status 

date box. 

Type 6/16/06 

5. Select OK. 

The Project Information dialog closes. 

Click OK 

 

Microsoft Project will use this date when comparing information to the baseline plan. 

 

Practice the Concept: Open the Project Information dialog box, enter 6/20/06 into 

the Current date box and close the dialog box. Drag the split bar to the left to display 

the Gantt chart. Notice that a dotted vertical line appears between the M (Monday) 

and T (Tuesday) for the week of Jun 18, ‘06, indicating the current date just entered. 

Drag the split bar as far right as possible. 
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UPDATING A TASK ON SCHEDULE 

 Discussion 

You can easily track a task that is on schedule using the Mark on Track button on the 

Task Ribbon. When Microsoft Project updates a task as on track, it uses the status 

date (or current date if a status date has not been set) to track progress. You can 

update completed tasks and tasks that are still in progress. A task that is in progress is 

one that has started but has not yet finished, and can be ahead of schedule, on 

schedule, or behind schedule. If a task is in progress, it will have a percent complete 

value between zero and 100.  

 

When you update a task as on track, Microsoft Project copies the scheduled date for 

the task into the Act. Start field for the task. It also estimates the percentage and 

amount of completed work for the task using the current date you entered and the start 

date of the task. It calculates the number of days between these two dates and divides 

that number by the total length of the task to calculate the percent complete value. 

 

 
Updating a task as on track 

 

  

 
A Planning Wizard dialog box opens if the time span includes 

a task with a constraint or deadline date. 

  

 
You can update multiple tasks on schedule by selecting the 

tasks before you click the Mark on Track button. 

  
 

 Step-by-Step 

Update a task as on track. 

 

If necessary, switch to the Gantt Chart view. Apply the Tracking table, drag the 

split bar as far right as possible, and display the Task Ribbon. 

 

Note: The status date for this project is set to 6/16/06. 
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Steps Practice Data 

1. Select the task in progress you want to 

update. 

The desired task is selected. 

Click the 2 Develop 

Blueprints task 

2. Click the Mark on Track button on 

the Task Ribbon. 

The appropriate fields for the task are 

updated or a Planning Wizard dialog 

box opens if the task has a constraint 

or deadline date. 

Click  

3. If a Planning Wizard dialog box opens, 

select OK. 

The project is updated. 

Click OK 

 

Notice that the % Comp. column displays 80% since this task is scheduled to be 

completed on 6/20/06. Mark the task as 100% complete. 

UPDATING A TASK NOT ON SCHEDULE 

 Discussion 

Tasks usually do not progress as originally planned. A task may start or finish early, 

on schedule, or late. You can enter the data in several different ways in these 

situations. 

 

If a task starts on schedule but finishes late, you can enter the actual finish date in the 

Act. Finish field of the Tracking table. Microsoft Project will then mark the task as 

100% complete in the % Comp. field. If a task starts early or late, but finishes on 

schedule, you can enter the actual start date in the Act. Start field of the Tracking 

table. You will also need to enter 100% in the % Comp. field as the task will not 

automatically be marked complete. If a task starts early or late and finishes early or 

late, you can enter the actual dates in the Act. Start and Act. Finish fields. Microsoft 

Project will automatically mark the task as 100% complete. 
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Updating a task not on schedule 

 

  

 
If a task with a constraint or deadline date is impacted by a 

task that is not on schedule, a Planning Wizard dialog box will 

open. You then need to select an option in the dialog box and 

adjust the schedule as necessary. 

  
 

 Step-by-Step 

Update a task not on schedule. 

 

If necessary, switch to the Gantt Chart view and drag the split bar as far right as 

possible. 

 

Apply the Entry table. Notice that the 3 Draft Proposal task is recorded as starting 

on 6/21/06 and finishing on 6/23/06. This task, however, started early and finished 

late. Apply the Tracking table. 

 

Steps Practice Data 

1. Select the Act. Start field for the 

desired task. 

The Act. Start field is selected for the 

desired task. 

Click the Act. Start field 

for the 3 Draft Proposal 

task 
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Steps Practice Data 

2. Enter the actual start date for the task. 

The actual start date appears in the 

Act. Start field. 

Type 6/20/06 

3. Select the Act. Finish field for the 

desired task. 

The Act. Finish field is selected for the 

desired task. 

Click the Act. Finish field 

for the 3 Draft Proposal 

task 

4. Enter the actual finish date for the 

task. 

The actual finish date appears in the 

Act. Finish field. 

Type 6/26/06 

5. Press [Enter]. 

The date is entered into the field, the 

task is marked as 100% complete, and 

the actual duration appears in the Act. 

Dur. field. 

Press [Enter] 

 

Practice the Concept: Enter the actual start date of 6/27/06 for the 4 Request Bids 

task. If necessary, display the Task Ribbon and mark the 4 Request Bids task as 

100% complete. This task started late due to the late start of the Draft Proposal task. 

In addition, the Contracting Specialist is assigned to the task and is on vacation from 

June 28 - July 4. However, the task was finished on time (i.e., according to the 

scheduled task duration of one week). 

VIEWING SLIPPAGE 

 Discussion 

If a task starts later than the original baseline start date, or the duration is longer than 

what was originally planned, the task has slipped. Microsoft Project refers to this 

situation as slippage, which is measured by the amount of time a task’s schedule is 

behind its baseline dates. 

 

You can view slippage in the Tracking Gantt view. The tracking Gantt chart is 

similar to the Gantt chart, but it has paired bars for each task. The lower bar displays 

the baseline start and finish dates and the upper bar displays the scheduled or actual 

start and finish dates (depending upon whether or not the task has started). If the bars 

do not line up on the timescale, the task has slipped. The farther apart the bars are 

located, the greater the slippage. 
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Viewing slippage 

 

  

 
You can also view slippage by using the Gantt Chart Wizard 

and selecting the Baseline format. 

  
 

 Step-by-Step 

View slippage. 

 

Switch to Tracking Gantt View. 

 

Scroll the right pane as necessary to view task slippage. Notice that the bars for the 

2 Develop Blueprints task through the 8 Select Subcontractors task do not line up, 

indicating that the tasks have slipped. 

 

Apply the Variance table and drag the split bar as far right as possible. Compare the 

baseline and actual start and finish dates. Notice the start variance and finish variance 

values for tasks 1 through 9. 

 

Return to the Gantt Chart view. 
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UPDATING PROJECTS ON SCHEDULE 

 Discussion 

If a project has proceeded as scheduled up to a certain date, Microsoft Project can 

automatically update the progress of all the tasks in that time span. By default, the 

program uses the status date for updating tasks. If you have not entered a status date, 

the current date will be used instead. However, while updating a project, you have the 

opportunity to enter another date. This date is then saved as the new status date for the 

project. 

 

If a task was completed before the end of the status date, it will be recorded as 100% 

complete. The original starting and ending dates, duration, work and cost values will 

be copied into the actual value fields. Values for incomplete tasks will be recorded 

according to the percentage of work assumed to have been completed. However, if 

you do not want to record information for incomplete tasks, you can choose to update 

tasks that have not yet started (0%) and those that are 100% complete only. 

 

You can choose to update the work for an entire project or just for selected tasks. In 

addition, you can reschedule uncompleted work to start after a date that you specify. 

 
The Update Project dialog box 

  

 
A Planning Wizard dialog box opens if the time span includes 

a task with a constraint or deadline date. 

  

 
To update selected tasks only, select them before opening the 

Update Project dialog box and then select the Selected tasks 

option. 
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 Step-by-Step 

Update a project on schedule. 

 

If necessary, switch to the Gantt Chart view and apply the Tracking table. 

 

Steps Practice Data 

1. Select the Project tab Click the Project tab 

2. Click the Update Project button. 

The Update Project dialog box opens 

 

3. Enter the desired date in the Update 

work as complete through box. 

The selected date appears in the 

Update work as complete through 

box. 

Change the date in the 

Update work as 

complete through box to 

7/24/06 

4. Select OK. 

The Update Project dialog box closes 

and a Planning Wizard opens or the 

project is updated using the selected 

date. 

Click OK 

5. If a Planning Wizard dialog box opens, 

select OK. 

The project is updated. 

Click OK 

 

Notice that completed values have been entered for the 5 Request Permits and 

6 Obtain Permits tasks, but the 7 Obtain Bids task is only 60% complete and still 

has a remaining duration of 0.4 wks. Drag the split bar to the left and view the 

progress bars for the tasks. 

ENTERING THE PERCENT COMPLETE 

 Discussion 

When you automatically update a task as scheduled, Microsoft Project calculates the 

percent complete value for the task using the number of days between the current date 

you entered and the start date of the task. Sometimes the number of days passed is not 

a true indicator of the actual percentage of work completed on the task. You will then 

want to enter the percent complete value manually to indicate a more realistic estimate 

of the completed work. 
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While you can use the buttons on the Task Ribbon to enter values in 25% increments, 

you may need to enter a value, such as 40%. Any percentage of completed work can 

be recorded by directly typing the value into the % Work Complete field. This field 

is available by displaying the Tracking table. In addition, you can also use Update 

Tasks dialog box to enter the percent of work complete. When entering completion 

percentages, you can either type the value or use the corresponding spin box. 

 
The Update Tasks dialog box 

 

  

 
After selecting a task, you can open the Update Tasks dialog 

box using the Update Tasks option (click the drop down 

arrow to the right of the Mark on Track button) on the Task 

Ribbon.You can use the Update Tasks dialog box to update 

information in any of the fields that it contains. 

  

 
You can also enter a completion percentage for a task on the 

General page of the Task Information dialog box. 

  
 

 Step-by-Step 

Enter the percent complete. 

 

Display the Project Ribbon, and click the Project Information button to display the 

Project Information dialog box.  Enter a status date for the project of 7/28/2006, and 

click OK to close the dialog. 

 

Switch to Gantt Chart view, and if necessary, change the table view to Tracking. 
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Steps Practice Data 

1. To use the table to enter the percentage 

of work complete, select the % Work 

Complete field for the desired task. 

The field is selected and the spin box 

appears. 

Click in the % Work 

Complete field for the 

8 Select Subcontractors 

task 

2. Type the desired value. 

The value appears in the % Work 

Complete field. 

Type 65 

3. Press [Enter]. 

The progress information is updated. 

Press [Enter] 

4. To enter a percentage using the Update 

Tasks dialog box, select the task you 

want to update. 

The desired task is selected. 

Click the 8 Select 

Subcontractors task 

5. Enter the actual percentage of work 

completed in the % Complete field. 

The percentage appears in the % 

Complete field. 

Click the % Complete 

 to 80% 

 

If you had updated this task using the Mark on Track button, it would only reflect 

that it was 55% complete.  

 

View the task bar for the 8 Select Subcontractor task. Notice that 80% appears to the 

left of the task bar. 

 

ENTERING COMPLETED AND REMAINING WORK 

 Discussion 

Microsoft Project calculates work values for tasks. You can enter the total hours of 

work completed and remaining for a task. If a single resource is assigned the task, the 

work values are applied to that resource. If multiple resources are assigned to the task, 

the hours are distributed in relation to the percentage of time each resource is 

scheduled to spend on the task. 

 

To update your progress, you can also enter work values for individual resources 

assigned to the same task. If you have resources that are working on the same task at 

different rates, you should enter the work for the individual resources instead of the 

total for the task. When you enter these work values, Microsoft Project sums them 

automatically to calculate the total work completed on the task to date. 
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The Task Usage view with the Work table applied allows you to enter actual and 

remaining work values for tasks and individual resources.  

 

 
 

Entering actual work values – Task Usage View with Work Table 

 Step-by-Step 

Enter completed and remaining work values. 

 

Switch to the Task Usage view, apply the Work table, and drag the split bar as far 

right as possible. Double-click the right border of the Task Name column to view the 

entire field. 

 

Since the last time the 7 Obtain Bids task was updated, the Contracting Specialist 

has performed a total of 15 hours of work. In addition, due to a scheduling problem, 

you need to schedule this resource to perform 5 more hours of work that was 

originally scheduled for the Superintendent. 

 

Steps Practice Data 

1. To enter actual work completed, select 

the Actual field for the task or for the 

individual resource assigned to the 

task you want to update. 

The desired Actual field is selected. 

Click the Actual field for 

the Contracting 

Specialist resource 

assigned to the 7 Obtain 

Bids task 
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Steps Practice Data 

2. Enter the total number of hours of 

work completed on the task or the 

hours of work completed by the 

individual resource. 

The number of hours appears in the 

Actual field and Microsoft Project 

recalculates the amount of work in the 

Remaining field. 

Type 15 

3. Press [Enter]. 

The value is entered and the 

appropriate fields are updated. 

Press [Enter] 

4. To enter the remaining work, select the 

Remaining field for the task or for the 

individual resource assigned to the 

task you want to update. 

The desired Remaining field is 

selected. 

Click the Remaining field 

for the Contracting 

Specialist resource 

assigned to the 7 Obtain 

Bids task 

5. Enter the total number of hours of 

work completed on the task or the 

hours of work completed by the 

individual resource. 

The number of hours appears in the 

Remaining field. 

Type 10 

6. Press [Enter]. 

The value is entered and the 

appropriate fields are updated. 

Press [Enter] 

 

Since the Contracting Specialist will be working 5 extra hours on the 7 Obtain Bids 

task, change the Remaining work for the Superintendent to 6 hours. 

 

Practice the Concept: Scroll to the 12 Dig Foundation task. Enter 24 hours of actual 

work on the task row. Since both the Backhoe Operator and Backhoe are assigned 

equal work units for the task, the work is distributed equally, with each resource 

assigned 12 hours. 

 

Switch to the Gantt Chart view and drag the split bar as far right as possible. Change 

the status date to 8/8/06. Select tasks 6 through 12 and use the Mark on Track button 

on the Task Ribbon to update the tasks. 
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ENTERING ACTUAL AND REMAINING DURATIONS 

 Discussion 

You can update tasks by entering the actual or remaining duration of a task. You can 

enter this information in the Update Tasks dialog box or in the Act. Dur. or Rem. 

Dur. fields in the Tracking table. 

 

If you enter an actual duration that is less than or equal to the scheduled duration, 

Microsoft Project assumes that the work on the task is going according to schedule 

and automatically sets the actual start date as scheduled. Microsoft Project also 

completes the percent complete value and remaining duration by comparing the actual 

duration with the original duration. If you enter an actual duration that is greater than 

the original duration, Microsoft Project assumes that the task is complete and took 

longer than expected. The percent complete value is set to 100%, the remaining 

duration is set to zero, and the current duration is revised to match the longer duration. 

 

If you enter a remaining duration that is different from the current task duration or 

current remaining duration value, Microsoft Project assumes that you are providing a 

new estimate of the total duration of the task. If you enter a remaining duration of zero 

for a task that has started, Microsoft Project marks the task as 100% complete and 

enters the finish date per the original schedule. 

 

 Step-by-Step 

Enter actual and remaining durations. 

 

If necessary, switch to the Gantt Chart view, apply the Tracking table, and drag the 

split bar as far right as possible. 

 

Steps Practice Data 

1. Select the Act. Dur. or Rem. Dur. 

field for the task you want to update. 

The Act. Dur. or Rem. Dur. field is 

selected. 

Click the Act. Dur. field 

for the 13 Smooth 

Foundation task 

2. Enter the actual or remaining duration. 

The actual duration or remaining 

duration appears. 

Type 1.5d 

3. Press [Enter]. 

The actual or remaining duration is 

entered and Microsoft Project updates 

the appropriate fields. 

Press [Enter] 
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Notice that Microsoft Project enters a remaining duration of 1 day since the total task 

duration is 2.5 days. 

 

Practice the Concept: Enter a remaining duration of 0 days for the 13 Smooth 

Foundation task. Notice that the task is marked 100% complete. The 14 Pour 

Foundation task only took 1/2 day to complete. Enter an actual duration of .5 days 

and a remaining duration of 0 days. 

ENTERING TIMEPHASED WORK VALUES 

 Discussion 

Work and cost data that is reported per time interval is known as timephased 

information. Usage views, such as the Task Usage or Resource Usage view, display 

timephased assignment information in the right pane. 

 

The most accurate method of tracking work completed on a task is to enter the amount 

of actual work done by the resource each day (or the selected interval on your 

timeline). For example, if the painter spent 5 hours painting doors on October 30th 

and 8 hours on October 31st, you would enter actual work values of 5 hours for 10/30 

and 8 hours for 10/31 for the Painter resource on the Paint Doors task. 

 

You can record timephased work values in the Task Usage view by adding the Act. 

Work detail to the view. In addition, applying the Work table allows you to view the 

total hours worked for a task. While entering timephased information is the most 

accurate way to report progress, it is also the most time-consuming. 
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Entering timephased work values 

 

  

 
In addition to analyzing work over a period of time, you can 

analyze costs over a period of time by selecting Cost or 

Actual Cost field from the right click list. 

  

 
You can change the timescale in a usage view to record work 

per minute, hour, day, week, month, quarter, or you can create 

a custom time interval. The timescale is saved with the view. 

  

 
After entering a value in a cell in the timephased area, you can 

press one of the keyboard arrow keys to move in the desired 

direction. 

  
 

 Step-by-Step 

Enter timephased work values. 

 

Switch to the Task Usage view and apply the Work table.  Right-click in the right-

hand area of the screen and select the Actual Work command. If necessary, drag the 

split bar so that the timephased details start to the right of the Work field in the table. 

 

Select the 16 Frame House task and use the Scroll to Task button to scroll to the 

work assignment. 
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Steps Practice Data 

1. Select the Act. Work field for 

assigned resource for which you want 

to enter timephased work values. 

The desired Act. Work field for the 

resource is selected. 

Scroll as necessary and 

click the Act. Work field 

in the first T column 

under the 24h for the 

Carpenter resource (for 

the date 8/15/06) 

2. Enter the desired value. 

The desired value is entered. 

Type 28 

3. Press [Enter]. 

The actual work value for the resource 

is entered and added to the actual 

work value for the task. 

Press [Enter] 

4. Continue to change the work values as 

desired.  Add actual hours for the 

Carpenter on the Frame House Task. 

The contour of the work assignment 

changes accordingly. 

Enter 28 hours of actual 

work for Wednesday, 

press the right arrow, 

Enter 20 hours of actual 

work for Thursday and 

Friday  

 

Practice the Concept: Scroll to the week of Aug 27, 06. For the carpenter, enter 24 

hours of actual work for Monday. Due to good weather, the carpenters are ahead of 

schedule. Enter 16 hours of actual work for Tuesday, which finishes the task. 

 

Because Microsoft Project does not know that the task is done, it scheduled the 

remaining 8 hours of work on Wednesday. Add the Remaining Duration field to the 

Gantt table and change the value to 0d and close the dialog box. Notice that the 8 

hours of work scheduled for Wednesday was removed. Marking the task as 100% 

complete would not have removed the 8 hours of work scheduled for Wednesday. 

Microsoft Project would have assumed that the task was completed as scheduled. 

RESCHEDULING UNCOMPLETED WORK 

 Discussion 

Projects do not always proceed according to plan. If work has not been completed on 

time, you can reschedule the uncompleted work for another date. You can manually 

reschedule the work by splitting a task or you can let Microsoft Project reschedule the 

uncompleted work for you. 

 

When Microsoft Project reschedules a task, it reschedules uncompleted work after the 

status date or a date you specify. You can let the program reschedule uncompleted 

work for the entire project or for selected tasks only. 
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If you use the status date to reschedule work, you can use the Calculation page in the 

Options dialog box to choose how rescheduled work that is completed should be 

treated. Work completed after the status date can be moved back to the status date and 

work completed before the status date can be moved forward to the status date. 

 

  

 
If you use the status date to reschedule work for a specific 

task, you can select the task and use the Update Project 

button on the Task Ribbon. 

  

 
If you do not want Microsoft Project to split tasks that are 

partially complete, you can disable the Split in-progress tasks 

option on the Schedule page of the Options dialog box.  

  
 

 Step-by-Step 

Reschedule uncompleted work. 

 

If necessary, display the Task Ribbon. 

 

Switch to the Gantt Chart view and apply the Entry table. Select the 17 Frame 

Garage task and mark it as 50% complete. Drag the split bar to the left and scroll to 

view the task bar for the task. 

 

The Carpenter has jury duty and probably cannot continue the rest of the work until 

after 9/8/06. You need to reschedule the remainder of the task. 

 

Steps Practice Data 

1. To reschedule the uncompleted work 

for specific tasks, select the desired 

tasks. 

The tasks are selected. 

Select the 17 Frame 

Garage task, if necessary 

2. Select the Project tab Click the Project tab 

3. Click the Update Project button. 

The Update Project dialog box opens 

 

5. Select the Reschedule uncompleted 

work to start after option. 

The Reschedule uncompleted work to 

start after option is selected. 

Click  Reschedule 

uncompleted work to 

start after 
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Steps Practice Data 

6. Type the desired date in the 

Reschedule uncompleted work to 

start after box. 

The selected date appears in the 

Reschedule uncompleted work to start 

after box. 

Type 9/8/06 

7. Select the Selected tasks option to 

reschedule work for selected tasks 

only. 

The Selected tasks option is selected. 

Click  Selected tasks 

8. Select OK. 

The Update Project dialog box closes 

and uncompleted work before the 

selected date is rescheduled. 

Click OK 

 

The Frame Garage task is split, with the uncompleted work rescheduled to start after 

9/8/06. The duration of 3 days remains unchanged. 

 

The carpenter was able to return early and finish framing the garage by 9/6/06. Open 

the Project Information dialog box and change the status date to 9/6/06. Use the Task 

Ribbon to mark the Frame Garage task as 100% complete. Notice that the progress 

bar indicates the work was completed after the rescheduled date of 9/8/06. Use the 

Undo button to undo marking the task complete. 

 

You can use the rescheduling options to move completed work around the current 

status date. Select the File tab, the Options command, and the Advanced tab. Select 

the Move end of completed parts after status date back to status date option and 

select OK. Once again, mark the Frame Garage task as 100% complete. Notice that 

the completed rescheduled work has moved back to the status date. 

 

Open the Options dialog box, deselect the Move end of completed parts after status 

date back to status date option and select OK. 

 

 

APPLYING PROGRESS LINES 

 Discussion 

Microsoft Project provides many ways to view the progress of a project. In addition to 

the different views available, you can display progress lines on the Gantt chart. 

Progress lines connect tasks in progress and contain peaks that illustrate whether or 

not a task is behind or ahead of schedule. If a peak points to the left, then the task is 

behind schedule; if a peak points to the right, then the task is ahead of schedule. 
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When you apply progress lines, you can display them as of the current date or the 

status date entered in the Project Information dialog box. The project status date is any 

date you specify for checking progress. You can also display progress lines on 

particular dates and at recurring intervals. In addition, you can display progress lines 

in relation to the actual plan or the baseline plan. 

 
The Progress Lines dialog box 

 

  

 
You can display additional progress lines at various dates 

using the Progress Line Dates list in the Progress Lines 

dialog box. You can also use the Add Progress Line button 

on the Task Ribbon to create additional progress lines. To 

remove any additional progress lines you have created, open 

the Progress Lines dialog box and use the Delete button. 

  

 
You can double-click an existing progress line to open the 

Progress Lines dialog box. 

  
 

 Step-by-Step 

Apply progress lines. 

 

If necessary, switch to the Gantt Chart view. 

 

Check how your project was progressing on June 23, 2006. Open the Project 

Information dialog box and enter a status date for the project of 6/23/06. Scroll to 

view the Gantt bars for tasks 3 and 4. 
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Steps Practice Data 

1. Select the Format  tab. 

The Format Ribbon appears. 

Click Format 

2. Click the drop down under the 

Gridlines button 

 

3. Select the Progress Lines command. 

The Progress Lines dialog box opens. 

Click Progress Lines... 

4. Select the Dates and Intervals tab. 

The Dates and Intervals page 

appears. 

Click the Dates and 

Intervals tab, if necessary 

5. Select the Always display current 

progress line option. 

The Always display current progress 

line option is selected. 

Click  Display: 

6. Select the At project status date or 

At current date option. 

The desired option is selected. 

Click  At project status 

date, if necessary 

7. Continue to select options as desired. 

The desired options are selected. 

Click the  Baseline plan 

option under Display 

progress lines in relation 

to 

8. Select OK. 

The Progress Lines dialog box closes 

and the progress lines are applied 

accordingly. 

Click OK 

 

Notice that the progress line appears on the status date of 6/23/06. The peaks point to 

the left, indicating that the Draft Proposal and Request Bids tasks were behind 

schedule. 

 

Change the status date to 8/10/06. Scroll to view the task bars for the week of Aug 6, 

06. The 13 Smooth Foundation and 14 Pour Foundation tasks were ahead of 

schedule. 

 

Double-click the red progress line to open the Progress Lines dialog box. Deselect the 

Always display current progress line option to remove the progress lines from the 

Gantt chart and close the dialog box. 
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VIEWING SUMMARY INFORMATION 

 Discussion 

As you work on your project, you can quickly view summary information in the 

Project Statistics dialog box. This dialog box is split into three different areas. The top 

area of the dialog box shows a comparison of the current, baseline, actual, and 

variance information for a project’s start and finish dates. The middle area displays 

the current, baseline, actual, and remaining information for a project’s total duration, 

work, and cost. The area at the very bottom of the dialog box, in the far left corner, 

displays the percentage complete for duration and work. 

 
The Project Statistics dialog box 

 

 Step-by-Step 

View summary information. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project Ribbon appears. 

Click Project  

2. Select the Project Information 

button. 

The Project Information dialog box 

opens. 
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Steps Practice Data 

3. Select Statistics. 

The Project Information dialog box 

closes and the Project Statistics dialog 

box opens with the summary 

information displayed. 

Click Statistics... 

4. Select Close when you have finished 

viewing the summary information. 

The Project Statistics dialog box 

closes. 

Click Close 

 

Close HOUSE15.MPP. 

  



 

 

LESSON 7 -  
EVALUATING AND DISTRIBUTING DATA  

In this lesson, you will learn how to: 

 View earned value data  

 View earned value indicators  

 Create a report  

 Create a custom report  

 Create a crosstab report  

 Use the Backstage View Preview Pane  

 Change page setup options  

 Print a report  
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VIEWING EARNED VALUE DATA 

 Discussion 

As you record actual work on a project, you may want to know how the work 

performed compares to the baseline. Earned value analysis uses project costs to 

measure the performance of a project at the time of the project status date. By 

comparing the cost of work performed to cost of work budgeted, you can view the rate 

of progress for a project and predict the trend of the project’s success. If you do not 

enter a status date, Microsoft Project uses the current date to perform the earned value 

calculations. 

 

Earned value analysis is based on three key measurements; the budgeted cost of work 

scheduled to be performed (BCWS), the budgeted cost of work actually performed 

(BCWP), and the actual cost of work performed (ACWP). For example, at a specific 

date, a task that is budgeted to cost $8000 should have been 50% complete with a 

budgeted cost of $4000. At this date, the task is behind schedule and is only 45% 

complete. According to the original budget, the work performed so far should cost 

$3600 (8000*.45). However, the actual cost for the work performed is only $3000. So 

while the task is behind schedule, the cost is less than budgeted. 

 

Microsoft Project provides three tables with earned value data; Earned Value, 

Earned Value Cost Indicators, and Earned Value Schedule Indicators. 

 

The Earned Value table is available for both tasks and resources. This table provides 

all the cost of work information to help you monitor your progress. The fields in this 

table are described below: 

 

Field Description 

BCWS This field displays the budgeted cost of work scheduled 

through the status date or current date. 

BCWP This field displays the budgeted cost of work performed 

through the status date or current date. 

ACWP This field displays the actual cost of work performed through 

the status date or current date. 

SV This field displays the earned value schedule variance 

through the status date [ SV = BCWP - BCWS ]. A positive 

value indicates that costs are under budget and a negative 

value indicates tasks are over budget. 

CV This field displays the earned value cost variance through the 

status date [ CV = BCWP - ACWP ]. A positive value 

indicates that costs are under budget and a negative value 

indicates tasks are over budget. 
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Field Description 

EAC This field displays the estimated cost at completion. This 

field reflects the expected cost of the task based on costs 

already incurred and costs planned for the remainder of the 

task. 

BAC This field displays the budgeted cost at completion. This field 

reflects the baseline cost for a task. 

VAC This field displays the variance at completion. This field 

reflects the difference between the baseline cost and the 

expected cost for a task [ VAC = EAC - BAC ]. 

 

 

 

 

 

Viewing earned value data 

 

  

 
A screen tip with help on any earned value field is displayed 

when you point to the top of the column above the field name  
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You can change earned value options for all tasks using the 

Earned Value button on the Advanced page in the Options 

dialog box. You can change the earned value calculation 

method and select which saved baseline you want to use for 

comparison. The default earned value method is % Complete, 

which bases the calculation on duration. The Physical % 

Complete option is a measure that disregards the total or 

actual duration of the task. For example, it takes 4 days to 

frame a garage. Using duration, the job is considered 50% 

complete after 2 days of work. In actuality, three of the four 

walls are finished since the last wall alone takes 2 days. Using 

the Physical % Complete option, you could mark the job as 

75% complete. 

  

 
To change the earned value method for an individual task 

only, open the Task Information dialog box and use the 

Earned value method option on the Advanced tab. 

  
 

 Step-by-Step 

From the Student Data directory, open HOUSE16.MPP. 

View earned value data. 

 

If necessary, switch to the Gantt Chart view, and change the Gantt table view to 

Earned Value 
 

Open the Project Information dialog box and enter a project status date of 9/8/06. 

 

Drag the split bar as far right as possible to view the earned value data. 

VIEWING EARNED VALUE INDICATORS 

 Discussion 

The earned value tables of schedule and cost indicators allow you to analyze the 

progress and trend of your project. With this information you can judge if you are 

running ahead of schedule, on schedule, or behind schedule, and if you have enough 

money to complete the project. You can then make adjustments and prepare for future 

needs. These tables are available for task views only. 

 

The Earned Value Cost Indicators table includes the BCWS, BCWP, CV, BAC, 

EAC, VAC fields and the additional fields below: 
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Field Description 

CV% This field displays a percentage that compares how much it 

should have cost to achieve the amount of work completed to 

how much it actually cost [ CV% = ((BCWP - ACWP) / 

BCWP) * 100 ]. A positive value indicates that a task is under 

budget, while a negative value indicates a task over budget. 

CPI This field provides a ratio of baseline cost of work to actual 

cost of work [ CPI = BCWP / ACWP ]. A value less than 1 

indicates a task over budget and a value greater than 1 

indicates a task under budget. 

TCPI This field shows the ratio of work remaining to be done to 

funds remaining to be spent, as of the status date [ TCPI = 

(BAC - BCWP) / (BAC - ACWP) ]. A value greater than 1 

means that you will have to increase performance for rest of 

project to stay within budget. A value less than 1 means that 

you are under budget. 

 

The Earned Value Schedule Indicators table includes the BCWS, BCWP, SV fields, 

and the additional fields below: 

 

Field Description 

SV% This field displays the percentage that a task is on, over or 

under schedule [ SV% = (SV / BCWS) * 100 ]. A positive 

value means that the task is ahead of schedule, while a 

negative value means that it is behind schedule. 

SPI This field displays a ratio that compares the cost of work 

performed with the cost of work scheduled [ SPI = BCWP / 

BCWS ]. A value greater than 1 means that the work is ahead 

of schedule, while a value less than 1 means the work is 

behind schedule. 

 

 
Viewing the Earned Value Schedule Indicators table 



Lesson 7 - Evaluating and Distributing Data Project - Lvl 2 

Page 94  

 

 

 Step-by-Step 

View earned value indicators. 

 

If necessary, switch to the Gantt Chart view and enter a project status date of 9/8/06. 

 

Steps Practice Data 

1. Select the View tab. 

The View Ribbon appears. 

Click the View tab 

2. Click on the arrow at the bottom of the  

Table button. 

The Table list appears. 

 

3. Select the More Tables command. 

The More Tables dialog box opens. 

Click More Tables... 

4. Select Earned Value Cost Indicators 

or Earned Value Schedule 

Indicators in the Tables list box. 

The table is selected. 

Click Earned Value 

Schedule Indicators 

5. Select Apply. 

The table is applied to the view and 

the earned value data appears. 

Click Apply 

 

If necessary, drag the split bar to the right to view the SV% and SPI fields. Change 

the project status date to 10/27/06. Scroll to view the earned value indicators for tasks 

20 through 29. Tasks with a negative SV% value and a SPI value less than 1 are 

behind schedule. 

 

Practice the Concept: Apply the Earned Value Cost Indicators table. 
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CREATING A REPORT 

 Discussion 

Microsoft Project provides a variety of reports you can use to view and distribute 

project information. On the Project tab. The Reports Group has several buttons for 

reporting options.   

 
 

The Reports Group on the Project Tab 

 

When you click the Reports Button you can choose reports from the following 

categories: Overview, Current, Costs, Assignments, Workload, and Custom. 

 

The Overview category provides reports that reflect summary information for the 

entire project, such as summary tasks and working days. The Current category offers 

reports that contain a variety of task information, such as tasks starting soon, in 

progress, and complete. The Costs category contains reports that reflect a variety of 

cost information, such as overbudget tasks and resources. The Assignments category 

provides reports containing resource assignment information, such as who does what, 

when, and overallocated resources. The Workload category offers two types of 

reports: task usage and resource usage. The Custom category allows you to create 

custom reports that reflect the specific information you need. 

 

 

 Step-by-Step 

Create a report. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project Ribbon appears. 

Click the Project tab 

2. Select the Reports button. 

The Reports dialog box opens. 
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Steps Practice Data 

3. Double-click the desired report 

category. 

The report dialog box for the selected 

category opens with the available 

reports displayed.  

Double-click Costs... 

4. Double-click the desired report. 

The report appears in the Backstage 

View Preview Pane. 

Double-click Overbudget 

Resources 

5. Click the Zoom button in the lower 

right or click on the preview area to 

zoom in. 

The view is magnified. 

Click  in the lower 

right hand corner of the 

screen to zoom in 

 

If necessary, click the Zoom button to magnify the report and scroll to read it. Notice 

that the Electrician, Contracting Specialist, Cable Specialist and Laborer resources 

are over budget. Select Close after reading the report and then select Close to close 

the Reports dialog box. 

CREATING A CUSTOM REPORT 

 Discussion 

You can create custom reports by creating a new report or by copying an existing 

report and modifying it. Custom reports reflect only the information you need. The 

Base Calendar and Project Summary reports are the only reports you cannot copy 

and modify. 

 

When you create a custom report, you work in the Reports dialog box, which has three 

tabbed pages. On the Definition page, you type a name for the report, select the time 

period to include, and select the table and filter to apply. You can select a predefined 

table or filter, or use a custom one you created. This page also includes options to 

highlight the items that meet the filter criteria, print gray bands between tasks or 

resources, and include summary tasks. On the Details page, you can select the task, 

resource, or assignment details you want to include in the report, as well as how you 

want them to appear. The options available on this page vary depending on the type of 

report. On the Sort page, you can choose the field(s) by which you want to sort the 

report information and the sort direction. 
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Creating a custom report 

 

  

 
You can also create a custom report by editing an existing 

report. Select the report in the Custom Reports dialog box, 

select the Edit button, and then make the desired changes. The 

changes to the report only apply to the current file; the same 

report in other files is not affected. 

  

 
To create a new custom report, select New in the Custom 

Reports dialog box, select the report type, and then select OK. 

You can then name the report and set its properties in the 

<report type> dialog box. 

  
 

 Step-by-Step 

Create a custom report. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project Ribbon appears. 

Click the Project tab 

2. Select the Reports button. 

The Reports dialog box opens. 

 

3. Double-click the Custom category. 

The Reports dialog box closes and the 

Custom Reports dialog box opens. 

Double-click Custom... 
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Steps Practice Data 

4. Select the report you want to copy in 

the Reports list box.  

The desired report is selected. 

Scroll as necessary and 

click Who Does What 

5. Select Copy. 

The appropriate report dialog box 

opens with the Definition page 

displayed. 

Click Copy... 

6. Select the text in the Name box. 

The text is selected. 

Drag to select the text in 

the Name box 

7. Enter the name of the report. 

The desired name appears in the 

Name box. 

Type Who Did What 

8. Select the Period list. 

A list of available time periods 

appears. 

Click Period  

9. Select the desired time period. 

The desired time appears in the Period 

box. 

Click Entire Project 

10. Continue to select options on the 

Definition page as desired. 

The desired options are selected. 

Select Work Complete 

from the Filter list. 

 

11. Select the Details tab. 

The Details page appears. 

Click the Details tab 

12. Select the desired options on the 

Details page. 

The desired options are selected. 

Click  Cost below 

Assignment 

13. Select the Sort tab. 

The Sort page appears. 

Click the Sort tab 

14. Select the Sort by list. 

A list of sort options appears. 
Click Sort by  

15. Select the desired sort option. 

The desired sort option appears in the 

Sort by box. 

Scroll as necessary and 

click Name 

16. Select the Ascending or Descending 

option to indicate the sort order. 

The desired sort order option is 

selected. 

Click  Ascending, if 

necessary 
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Steps Practice Data 

17. Select OK. 

The report dialog box closes and the 

custom report is selected in the 

Custom Reports dialog box. 

Click OK 

18. Select Preview to view the report. 

The custom report appears in the 

Backstage View Preview Pane. 

Click Preview 

 

Click the Zoom button to magnify the report and scroll as necessary to read it. Select 

Close after reading the report and then continue to select Close to close all open 

dialog boxes. 

CREATING A CROSSTAB REPORT 

 Discussion 

A crosstab report allows you to compile task or resource information across a 

specified time period. The cost or work information for the tasks or resources is listed 

for each division of the time period. For example, you can display work information 

per week by resource. 

 

Creating a crosstab report is similar to creating other reports. You create a crosstab 

report in the Crosstab Report dialog box, which has three tabbed pages. The 

Definition page varies slightly as you select row and column options, as well as the 

calculated field for the body of the report. The Details page also varies slightly in the 

type of options available. You can use the options on the Details page to change the 

appearance of the report by adding row and column totals and gridlines. On the Sort 

page you can choose the field(s) by which you want to sort the report information and 

the sort direction. 

 
Viewing a crosstab report 
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 Step-by-Step 

Create a crosstab report. 

 

Create a new custom filter called Tasks with Durations Greater Than 3 Days. 

Select the field name Duration, select the test criteria is greater than, and enter 3 to 

indicate the value. Close the More Filters dialog box without applying the new filter. 

 

Steps Practice Data 

1. Select the Project tab. 

The Project Ribbon appears. 

Click the Project tab 

2. Select the Reports button. 

The Reports dialog box opens. 

 

3. Double-click the Custom category. 

The Custom Reports dialog box opens. 

Double-click Custom...  

4. Select New. 

The Define New Report dialog box 

opens. 

Click New... 

5. Select Crosstab in the Report type 

list box. 

The Crosstab option is selected. 

Click Crosstab 

6. Select OK. 

The Define New Report dialog box 

closes and the Crosstab Report dialog 

box opens. 

Click OK 

7. Select the text in the Name box. 

The text is selected.  

Drag to select the text in 

the Name box 

8. Enter a name for the crosstab report. 

The name appears in the Name box. 

Type Task Costs by 

Month 

9. Select the Row list. 

The Tasks and Resources options 

appear. 

Click Row  

10. Select Tasks or Resources. 

The desired option appears in the Row 

box. 

Click Tasks 

11. Select the Column list. 

The Column list appears. 
Click Column  
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Steps Practice Data 

12. Select the time period. 

The desired time period appears in the 

Column box. 

Click Months 

13. Select the calculation list that appears 

at the intersection of the row and 

column. 

A list of options appears. 

Click the calculation list 

 that appears at the 

intersection of the row and 

column 

14. Select the calculation option. 

The desired calculation option is 

selected. 

Click Cumulative Cost 

15. Select the Filter list, if desired. 

A list of available filters appears. 
Click Filter  

16. Select the desired filter. 

The desired filter is selected. 

Click Tasks with 

Durations Greater Than 

3 Days 

17. Select the Details tab. 

The Details page appears. 

Click the Details tab 

18. Select the desired options under Show. 

The desired options are selected. 
Click  Column totals 

19. Continue to select options on the 

Details page as desired. 

The desired options are selected. 

Click  Between tasks 

below Gridlines 

20. Select the Sort tab. 

The Sort page appears. 

Click the Sort tab 

21. Select the Sort by list. 

A list of sort options appears. 
Click Sort by  

22. Select the field by which you want to 

sort. 

The desired field appears in the Sort 

by box. 

Scroll as necessary and 

click Start 

23. Select the Ascending or Descending 

option. 

The desired option is selected. 

Click  Ascending, if 

necessary 

24. Select OK. 

The Crosstab Report dialog box closes 

and the new report is selected in the 

Custom Reports dialog box. 

Click OK 
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Steps Practice Data 

25. Select Preview. 

The new crosstab report appears in 

the Backstage View Preview Pane. 

Click Preview 

 

Click the Zoom button to magnify the report and scroll as necessary to read it. Select 

Close after reading the report. With the Task Costs by Month report still selected, 

click Edit. Change the filter on the Definition page to All Tasks and preview the 

report again. Close all open dialog boxes. 

USING THE BACKSTAGE VIEW PREVIEW PANE 

 Discussion 

Before you print a view or a report, you can preview it. The Print Preview window 

displays the view as it would look on the printed page. This view allows you to make 

changes to the layout before you print, saving time and paper. When you create a 

report, it automatically appears in the Backstage View Preview Pane. When you 

create a custom report, you need to select the Preview button in the Custom Reports 

dialog box to open the Backstage View Preview Pane. 

 

The Office 2010 Backstage View preview window has a special set of tools, in the 

lower right hand corner of the preview pane, that enable you to manipulate the view to 

magnify information; page right, left, up, and down; and display multi-page views. 

 

 
 

  

 
Project views, like reports, can also be printed.  To print the 

Gantt Chart view, arrange the screen the way you’d like it to 

appear on the printed page, select the File tab and click Print. 

  

 
You can also zoom the Backstage View Preview Pane with the 

mouse pointer. To zoom in, click the mouse pointer, which 

appears as a magnifying glass with a plus sign (+), on the text 

you want to enlarge. The plus sign on the mouse pointer 

changes to a minus sign (-). To zoom out, click the mouse 

pointer anywhere in the window. 
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 Step-by-Step 

Use the Backstage View (Print Preview) Page. 

 

Create the Who Does What When report that appears in the Assignments category. 

Notice that it opens in the Backstage View (Print Preview).  

 

Steps Practice Data 

1. Click the Zoom button to read the 

report. 

The report is magnified. Click  

2. Click anywhere in the window to 

zoom out. 

The report returns to full page view.  

Click anywhere in the 

window 

3. Click the Page Right button or the 

Page Down button to move to a 

following page in a multi-page view. 

The next page appears. 

 

Click or   

4. Click the Page Left button or the Page 

Up button to move to a previous page. 

The previous page appears. 

 

Click  or   

5. Click the Multiple Pages button to 

view more than one page. 

Multiple pages appear. 

Click    

6. Click the One Page button to return to 

a single-page view. 

One page appears. 
Click  

7. Click the Project Tab to Return to the 

project. 

Click the Project tab 

 

Select Close to close the Reports dialog box. 



Lesson 7 - Evaluating and Distributing Data Project - Lvl 2 

Page 104  

 

CHANGING PAGE SETUP OPTIONS 

 Discussion 

Before printing a report, you may need to make some changes to the page setup. 

When you create a report, it either appears automatically in the Backstage View with 

the Print Preview pane, with basic printing options displayed as shown below: 

 

 
 

For additional printing options, click the Page Setup link to open the page setup dialog 

box as shown below.  You can change the orientation and margins, as well as add a 

header and/or footer to your reports. You can type text, or you can enter codes to print 

the current date, time, file name, or page number. In addition, you can add project-

level fields, such as % Complete, to a header or footer as desired. 

 
The Page Setup dialog box 
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 Step-by-Step 

Change page setup options. 

 

Create the Overbudgeted Resources report that appears in the Costs category. Notice 

that it opens in the Backstage View Preview Pane window. 

 

Steps Practice Data 

1. Select Page Setup from the Backstage 

View Preview Pane window. 

The Page Setup dialog box opens. 

Click Page Setup... 

2. Select the Page tab. 

The Page page appears. 

Click the Page tab, if 

necessary 

3. Select the Portrait or Landscape 

option under Orientation. 

The desired orientation option is 

selected. 

Click  Landscape, if 

necessary 

4. Select the Footer tab. 

The Footer page appears. 

Click the Footer tab 

5. Select the desired alignment tab. 

The desired alignment page appears. 

Click Right 

6. Select the General or Project fields 

list at the bottom of the Footer page. 

A list of footer options appears. 

Click General   

7. Select the desired option. 

The desired option is selected. 

Scroll as necessary and 

click Project Current 

Date 

8. Select the Add button next to the 

corresponding option. 

The desired option appears it the 

preview area. 

Click Add next to the 

General option 

9. Select OK. 

The Page Setup dialog box closes and 

the desired page setup changes appear 

in the Backstage View Preview Pane. 

Click OK 

 

Click the Project Tab to return to the project.  

Close HOUSE16.MPP.  





 

 

LESSON 8 -  
FINALIZING A PROJECT  

In this lesson, you will learn how to: 

 Mark tasks complete  

 Correct actual data  

 Analyze final data  

 Use final data in a new project  

 Copy task names to a new project  
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MARKING TASKS COMPLETE 

 Discussion 

When your project is finished, all tasks should be marked as 100% complete. Often, 

some tasks may be overlooked and not marked complete, even though the project has 

ended. You should mark all tasks as 100% complete before beginning your analysis of 

the actual information versus baseline information. 

 

 Step-by-Step 

From the Student Data directory, open HOUSE17.MPP. 

Mark tasks complete. 

 

If necessary, switch to the Gantt Chart view. 

 

Filter for Incomplete Tasks and then display the Task Ribbon. 

 

Steps Practice Data 

1. Select all the incomplete tasks. 

All the incomplete tasks are selected. 

Click the Select All button 

(the gray button at the 

intersection of the ID 

column and field name 

row) 

2. Mark all remaining tasks as 100% 

Complete. 

The selected tasks are marked 

complete. 

Click the Task tab then 

Click  

 

Notice that a check mark now appears to the left of the selected tasks. Return to the 

View Ribbon and filter again for all tasks. 

CORRECTING ACTUAL DATA 

 Discussion 

The project is complete when all tasks are marked as 100% complete. Microsoft 

Project calculates the duration, resource usage, and costs for the individual tasks and 

for the project in its entirety. All of these calculations are based on the available 

schedule information. This information may or may not reflect what actually 
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happened on the project. You may need to enter actual information manually in order 

to get an accurate picture of the final project information. For example, a task may 

have had a duration of three days, but the resources only worked on the task for six 

hours on the last day. In this situation, you would need to adjust the data to reflect 

actual hours, which would alter your cost information, making it more accurate. 

Manually entering actual information should be done before comparing the actual 

information to the baseline information.  

 

 

 

 

 

  
Correcting actual data 

 

 Step-by-Step 

Correct actual data. 

 

Switch to the Resource Usage view and apply the Cost table. Drag the split bar so 

that only the Resource Name and Cost fields appear in the left pane. Scroll down as 

necessary to view the resource cost (3 Electrician) for the Initial Electricity task, 

which is $7,200.00. Scroll the right pane as necessary to display the work values for 

the week of Oct 15, 06. 
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Steps Practice Data 

1. Select the Format tab. 

The Format Ribbon appears. 

Click Format 

2. Select the desired field. 

The desired field is added to the 

current view. 

Click Actual Work 

3. Select the field containing the value 

you want to correct. 

The desired field is selected. 

Scroll as necessary and 

click 24h that appears in 

Act. W field in the T 

(Tuesday) column for the 

week of Oct 15, 06 (for 

the Initial Electricity 

task) 

4. Enter the actual data. 

The actual data appears in the 

selected field. 

Type 18h 

5. Press [Enter]. 

The correct value is entered into the 

selected field. 

Press [Enter] 

 

Notice that the resource cost for the Initial Electricity task is now $7,020.00, a 

difference of $180 dollars. 

 

Practice the Concept: Scroll down as necessary to view the resource cost 

(4 Plumber) for the Initial Plumbing task, which is $5,600.00. Scroll the right pane 

to view the week of Oct 8, 06. Change the work values in the Act. Work fields for 

Wednesday (W) and Friday (F) from 16h to 10h. Notice that the resource cost is now 

$5,000.00, a difference of $600. 

 

Switch to the Gantt Chart view. 

ANALYZING FINAL DATA 

 Discussion 

After a project has been completed, it is recommended that you analyze the final data 

and review any problems that may have occurred during the project. If you are able to 

learn the causes of these problems, then you can prevent them from happening on 

future projects. The areas that should be reviewed include actual versus baseline dates, 

durations, costs, and work; as well as recurring problem areas. 

 

Once all tasks are marked complete and the actual information is correct, you can 

compare baseline data versus actual data for resource usage, costs, dates, and 

durations. You can determine how accurate the baseline forecasts were and what 
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actions should be taken in the future on similar projects. You should review large 

variances to determine the cause of the problem so that you can prepare more accurate 

baseline data for future projects. 

 

You do not necessarily have to review every task in a project, but you should review 

those tasks that had the largest cost, schedule, and work variances. If the project did 

not go as planned, you could ask yourself questions such as: 

 

• What caused the continued cost growth or schedule slippage? 

• Were the problems a result of internal management factors, 

specification changes to the contract, or economic factors such as 

inflation? 

• What can prevent these problems from occurring in future projects? 

• Will employing more highly-skilled labor or using overtime be a 

solution? 

• Was a management reserve cost set aside at the beginning of the 

project to handle problem areas? 

 

The project manager should be aware of the problems in a project so that they can 

control future projects. 

 

 Step-by-Step 

Analyze final data. 

 

If necessary, switch to the Gantt Chart view. Drag the split bar as far right as 

possible. 

 

Steps Practice Data 

1. Select the View Tab. 

The View Ribbon appears. 

Click the View tab 

2. Click the Tables button. 

The Table list appears. 

 

3. Select the desired table. 

The desired table is applied to the 

view. 

Click Work 

 

Scroll to the 13 Smooth Foundation task. View the Variance field. Notice that due 

to good weather, the task took 24 hours less than planned. Notice that the 3 Draft 

Proposal task took 16 hours more than planned. 
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Practice the Concept: Apply the Cost table to the view. View the Variance field and 

notice that the 13 Smooth Foundation task had a cost variance of $720 less than the 

baseline cost. However, the 3 Draft Proposal task cost $432 more than planned. 

 

Apply the Variance table to the view. The Finish Var. field for the 13 Smooth 

Foundation task indicates that the task ended .5 work days earlier than planned. View 

the Start Var. and Finish Var. fields for the 17 Frame Garage task. Although the 

task started 1.5 days earlier than planned, it finished .5 day later than planned. 

 

Switch to the Resource Sheet view and apply the Cost table. View the Variance field 

and notice that the cost of all tasks assigned to the 4 Plumber was $600 less than 

planned. Apply the Work table. The Variance field for the 4 Plumber shows that it 

took 12 hours less than planned to complete the assigned work. 

 

Switch to the Gantt Chart view, apply the Entry table, and drag the split bar back to 

the right of the Duration field. 

USING FINAL DATA IN A NEW PROJECT 

 Discussion 

When you are starting a new project that is similar to a completed project, you can 

copy all the information from the completed project into the new project. After you 

copy the data, you can edit, insert, and delete information as desired. 

 

After copying a completed project, you should change all the tasks from 100% 

complete to 0% complete. You can update the durations, start dates, and links to 

create a baseline plan based on the final results of the completed project. In addition, 

you can update the resource and assignment information to reflect the needs of your 

new project. When you copy project information, the resource names from the 

completed project appear in the Resource Sheet view; however, each one is assigned 

a maximum unit value of 100%. Other resource information, such as costs, are not 

copied. 

 

When you copy project information, you can enter a new project start or finish date, 

but you will be advised of conflicts with any dates that have constraints applied to 

them. For this reason, it is recommended that you remove all constraints before you 

enter a start or finish date for your new project. Once you remove all constraints and 

enter the new start or finish date, all task dates are updated accordingly. You can then 

constrain and modify the tasks in your new project file as desired. 

 

When tasks are copied, the baseline values for those tasks are also copied. If you do 

not save a new baseline, the baseline dates from the original file from which you 

copied the data appear in the baseline fields, but have no effect on your project. When 

you are ready to save a baseline later, you can save it and all the baseline fields will be 

updated to reflect the current plan for the new project. 
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Using final data in a new project 

 

  

 
When you first copy the data to your new project file, all tasks 

reflect the original project dates. Once you mark all tasks as 

0% complete and remove the constraints, the tasks reflect 

dates based on the current date. You can change the dates by 

entering a project start or finish date in the Project Information 

dialog box. 

  

 
Before you copy final data and paste it into a new project, you 

should open the Resource Leveling dialog box and verify that 

Leveling calculations is set to Manual. The procedure may 

not work properly if this option is set to Automatic. 

  

 
To view tasks with constraints, select the Constraint Type 

option from the Group By box on the View ribbon. To view 

tasks with deadlines, select the Tasks With Deadlines option 

from the Filter list on the View ribbon. 

  
 

 Step-by-Step 

Use final data in a new project. 

 

If necessary, switch to the Gantt Chart view. Display the Task Ribbon. 
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Steps Practice Data 

1. Select the tasks you want to copy. 

The tasks are selected. 

Drag the to select the row 

headings for the 

1 Conduct Site Survey 
task through the 

39 Cement Work task 

2. Click the Copy Task button. 

The selected tasks are copied to the 

Windows Clipboard. 

Click  

3. Create a new project. 

A new project file opens. 

Click File, New, then 

double click  

Blank Project 

4. Click the Paste button. 

The tasks appear in the Gantt Chart 

view of the new project file or a 

Microsoft Project dialog box opens 

warning you about a task change. 

Click  

5. If a warning box opens, select OK to 

confirm changes made to task 

durations.  

The tasks appear in the Gantt Chart 

view of the new project file. 

Click OK 

6. Select all the tasks you copied. 

All the tasks are selected. 

Click the Select All button 

(the gray button at the 

intersection of the ID 

column and field name 

row) 

7. Click the 0% Complete button. 

The check marks to the left of all the 

copied, completed tasks disappear and 

any indicators reappear. 

Click   

8. To remove constraints and deadlines 

on all copied tasks, select the tasks and 

click the Task Information button on 

the Task Ribbon. 

The Multiple Task Information dialog 

box opens. 

Click  

9. Select the Advanced tab. 

The Advanced page appears. 

Click the Advanced tab 
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Steps Practice Data 

10. Remove all constraints and deadlines. 

A list of constraint types appears. 

Select the Constraint 

type list and select As 

Soon As Possible. Select 

the Deadline box and type 

NA. 

 

11. Select OK. 

The Multiple Task Information dialog 

box closes, all constraints and 

deadlines are removed, and all 

constraint indicators disappear. 

Click OK 

 

Click any task to deselect the selected tasks. Click the Project Tab, and open the 

Project Information dialog box. Enter a project start date of 1/1/2012. Drag the split 

bar to view the Start and Finish date fields. Notice that all dates were updated 

accordingly. Save the new project file to the student data folder as Build and then 

close it. 

 

Close BUILD.MPP. 

COPYING TASK NAMES TO A NEW PROJECT 

 Discussion 

You can also begin a new project by copying the task names from a previous project. 

When you copy only the task names, the task durations are not included. All copied 

tasks appear in the new project file with an estimated duration of one day. The 

advantage of copying only the task names is that you can then create a fresh baseline 

plan. You can set task durations, link tasks, and apply constraints, as if you had typed 

the tasks to start a new project. In addition, you can create and assign only those 

resources you need for this project. 
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Copying task names to a new project 

 Step-by-Step 

Copy task names to a new project. 

 

Switch to the Gantt Chart view, if necessary. 

 

Steps Practice Data 

1. Select the task names in the Task 

Name column that you want to copy to 

create a new file. 

The tasks are selected. 

Drag to select the task 

names of the 1 Conduct 

Site Survey task through 

the 39 Cement Work task 

2. Click the Copy Cell button. 

The selected tasks are copied to the 

Windows Clipboard. 

Click  

3. Create a new project. 

A new project file opens. 

Click File, New, then 

double click  

Blank Project 

4. Select the first field in the Task Name 

column. 

 

Click the first field in the 

Task Name column 

5. Click the Paste button. 

The task names appear in the Task 

Name column  
Click  

 

Notice that none of the tasks are linked or constrained as they were in the original file. 

Close the file without saving it. 

Close HOUSE17.MPP. 

 

  



Project - Lvl 2 Lesson 8 - Finalizing a Project 

 Page 117 

 

CREATING A PROJECT COMPARISON REPORT 
 

 

 
The Project Comparison Report  

 Discussion 

Sometimes you may want to compare one project to another or a given project to an 

earlier version of itself.  The Compare Projects button on the Project tab allows you to 

see the differences between any two selected projects.  The Compare Project dialog 

box allows you to select the two projects, and the specific data you wish to compare 

by selecting one Task and one Resource table to be included in the comparison report. 

When you compare two projects, Microsoft Project creates a third project named  

“Comparison Report” that identifies the differences between the two projects you 

selected, and tags those changes with special symbols to identify the type of 

difference.  The Gantt bars for each project will be color coded and displayed on a 

common Gantt chart. 
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 Step-by-Step 

Compare two projects. 

 

Open  HOUSE15.MPP. 

Click to select the Project tab, if necessary. 

 

Steps Practice Data 

1. Click the Compare Projects button to 

select a second project. 

 

Click  

2.  Browse to select the second project 
Click the  

button and select the 

House8.mpp 

3. Select the data tables that you wish to 

compare 

Change both the Task 

Table: and the Resource 

Table: drop down lists to 

Entry 

4. Click OK to begin the Project 

Comparison. 

A new project entitled Project 

Comparison is created, and a split 

window view opens, displaying the 

comparison Gantt chart at the top of 

the screen (in Task Comparison view), 

and the two selected projects at the 

bottom of the screen.  

 

Click OK 

5. Change the start date for the newly 

created project to match the compared 

projects 

Open the project 

information dialog for the 

Comparison Project and 

set the Project start date 

to 6/1/2006 

Click the Compare 

Projects tab to return to 

the comparison view 

6. Scroll through the Project Comparison 

Report at the top of the screen, noting 

the Comparison Legend at the left, and 

the appropriate symbols in the 

indicators column 

In the Comparison Report 

Gantt Chart at the top of 

the screen, click on the 

row selector for 

Task 4 Request Bids 
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Steps Practice Data 

7. View the same task in all three 

projects. 

The task is display in all three project 

  Click  

8. Switch to Resource Comparison  

The view changes to show you the 

Resource comparison at the top of the 

screen, and each project’s resource 

sheet at the bottom of the screen. 
Click  

9. Close the Comparison Tab 

The Comparison view tab is closed, 

and you are returned to the 

Comparison Report Project. Click  

10. Close the Comparison Report Close and Save the 

Comparison Report 

project adding today’s 

date to the end of the file 

name. 

11. Close the remaining open project files Close all remaining open 

projects. 
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